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About the Product

The Datgel Monitoring Tool gINT Add-In stores, calculates and reports monitoring installation and
readings data for the following instruments:

Settlement marker

Deep datum

Survey prism

Rod settlement gauge

Standpipe piezometer

= =4 =4 -4 -4 -

Vibrating wire piezometer
1 Magnetic extensometer

You need to complete the installation procedure (see Installation and Licensing on page 1) and activate
(see Datgel Product Licensing System User Guide) before you can use the Monitoring Tool.

Support

12 months support and maintenance is included with the license purchase. For technical support
please email support@datgel.com or call +61 2 8202 8600.

System Requirements

gINT

The product requires gINT 8.2.005 or higher to run. The tool includes a number of Graph, Graphic
Table and Graphic Text Documents reports that require gINT Professional.

Hardware and Operating System

Same system requirements as gINT 8.2, see: http://www.qgintsoftware.com/products_requirements.html.

Required Windows Components
1. Windows Installer 3.1
2. .NET 3.5 Framework SP1

Conventions and typography used in this guide

Note: Tips and additional Information to help you.

> Used to indicate a series of menu commands.
e.g. Select File > Open.

| Used to indicate a gINT Application Group, Application, Table Group or Table , e.g.
DATA DESIGN | Project Database

Bold Text Items you must select, command buttons, or items in a list.
e.g. Navigate to UTILITIES | Convert Projects (4" tab).

ltalics Emphasis Use to emphasize the importance of a point such as parameters.
e.g. Data Entry i Check Omit Must Save prompt when save is required

Monitoring Tool gINT Add-In Datgel
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CAPITALS Names of keys on the keyboard. for example, SHIFT, CTRL, or ALT.

KEY+KEY Key combinations, for example CTRL+P, or ALT+F4.
Code Snippet Indicates a code snippet within a paragraph
Code sample

Indicates a sample program codes inserted in user guide e.g.

public override string ToString ()

File name or path Used for formatting file name and paths e.g. di_lib.glb or
V:\ 10 gINT \ Datgel Install Files \
Table Name Database table name, e.g. POINT_TABLE

Field Name

Command line
cdir

Field Colours

Database field name; e.g. Point|D

Command line, presented exactly as it must be entered e.qg.

Each of the fields in the project tables have been coloured to improve the data entry process as

indicated below in Table 1.

Table 17 Field Colours

Field Colour

Field Name and Explanation

Yellow

gINT Key Field i mandatory data entry

Pastel Purple

AGS Data i data associated with the AGS Data
Interchange Format

Pastel Green

Calculated Field i data is written to this fieldby Dat g e
code

Data Entry Field 7 data should be entered into this field,

Pastel Beige or data in this field influences the calculation

Pastel Red Legacy Data Field i historic data entered here, is
typically from an old database

Pastel Blue Output Option T used to control how data displays on a

report

Pastel Orange

Remark or Metadata Field i additional data associated
with the primary information

Grey

Read-only

Monitoring Tool gINT Add-In
User Guide
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1

1.1

Insta llation and Licensing

Installation Overview

There are four parts to the installation process:

1
il
il

1

Install DLL program
Merge gINT library objects

Merge gINT project table objects to your project file and your data template

Activate the product license

The first three steps can be performed in any order and are described below. The activation procedure
must be done last and is described in the Datgel Product Licensing System User Guide.

1.2

Package Contents

Your software purchase may have come with the following contents:

1

T

1.3

Applications CD which normally has the following folders:
\ gINT Files

\ Datgel Network License Server

\ Documentation

\ Installation files

A hardware license key

Before Installation

A few basic preparations can help ensure an effortless installation.

1 Make sure that the computer where you plan to install the program meets the minimum
hardware and software requirements.

9  Connect your PC to Internet before installation (must have a working Internet connection).
The Monitoring Tool requires that the Microsoft .NET 3.5 framework SP1 is installed on the PC
prior to the installation of the Tool. If your PC does not have the .NET 3.5 framework SP1
installed, then it will be automatically downloaded and installed during the Tool installation
process.

1 Log into the PC with Administrator privileges before starting installation.

1 Itis recommended that you exit out of other applications that maybe running on your PC.

1 Close gINT before you start installation.

1 Keep the serial number and license number handy.

1.4 Install D LL Programs

1. If you received an installation CD, then insert the CD and browse to the folder
\Installation Files
Double click the file named Setup.exe

3. Click Run to begin installation.

Follow the on screen instructions when installation begins:
Monitoring Tool gINT Add-In T Datgel
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4. Click Next on the Welcome to the Datgel Monitoring Tool Setup dialog.
b & [

EL’@ Datgel Maonitoring Tool

Welcome to the Datgel Monitoring Tool Setup
Wizard

The installer will guide you through the steps required to install Datgel Monitoring Tool on your
computer.

WAARNIMG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it may resultin severe civil
or ctiminal penalties, and will be prosecuted to the maximum extent possible under the law.

5. Scroll and carefully read the License Agreement, and choose option | Agree, and click Next.
E=REeE

ngfl Datgel Monitoring Tool

License Agreement

Flease take a momentto read the license agreement now. If yvou accept the terms below, click "l
Agree'!, then "Next'". Otherwise click "Cancel".

LICENSE AGREEMENT

m| »

Terms and Conditions
This End User License Agreement relates to the program information and
data relating to the Product. The Licensor is Datgel Pty Ltd (ABN 31 116
883 731) (Datgel).

PRODUCTS

@1 Do Mot Agree ()1 Agree

I Cancel ‘ I < Back ‘ Next >

Alternatively choose | Do Not Agree and click Cancel if you disagree with the license
agreement. The installation will stop and exit.

6. On the Select Installation Folder dialog, either accept the default folder (recommended) or
select Browse to specify the folder where you want to install the Monitoring Tool Add-In.

Leave Everyone bulleted to indicate that anyone logged onto the PC can use the Monitoring
Tool Add-In.

Click Next when ready.

Monitoring Tool gINT Add-In T Datgel
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The installer will install Datgel Monitoring Tool to the following folder,

Toinstall inthis folder, click "Next". To install to a differentfolder. enter it below or click "Browse"

Folder:

CAProgram Files\Datgel\Datgel Monitoring Tooly, Browse

Install Datgel Monitoring Tool for yourself, or for anyone who uses this computer:

(@) Everyone
() Justme

I Cancel ] I < Back ] I Mext > ]

OPTIONAL Click on Disk Cost to view the disk space statistics. Click OK when done.

(/@ Datgel Monitoring Too! Disk Space |

The list below includes the drives you can install Datgel Monitoring Tool to, along with each drive's
available and reguired disk space.

Yalume Disk Size Awvailable FRec =
=C 146GE 73GB Ef
=D: 2047MB 1414MB

[=ex 1957hB 1450MB

S2M: KB KB

M 418GE 243GB

S20: 418GE 243GB

2P 418GE 243GB ¥
< | 11 | »

7. Click Next to start installation.

The installer is ready to install Datgel Monitoring Tool on your computer.

Click "Next" to start the installation.

Cancel ] [ < Back ] [ Next > ]

Monitoring Tool gINT Add-In i Datgel
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8. Observe the progress bar to monitor installation progress

ﬁ Datgel Monitoring Tool

| M R

Datgel Monitoring Tool is being installed.

Please wait...

E=lien

Cancel

< Back

Next >

9. Click Close when the Installation Complete dialog is displayed.

ﬁl Datgel Monitoring Tool

XN
ey o
e !

LY.
Datgel Monitoring Tool has heen successfully installed.

Click "Close" to exit.

Cancel

Please use Windows Update to check for any critical updates to the NET Framework.

< Back

o & s

Close

1.5 Merge gINT Library Objects

Note:l f youébére in one of t

he

f ol | oW.i7 Actjivate liicenseat i ons t hen pr o

In the trial version of the Monitoring Tool, the library will be locked and you cannot merge any gINT Library
Objects into your Library file, or make changes to this Library file. In this case, you have to use the locked

library as-is.

Steps 1.5 to 1.6 have already been completed by D a t g @elefogers, yourself or a colleague.

I f you dondédt have existing gl NT f il ®enitoting €ool giNDRilesmay wi s h
provided on the DVD.

Monitoring Tool gINT Add-In T Datgel
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If you have purchased the Monitoring Tool gINT Add-In, then you have full access to the library objects,
and you may proceed with the following steps to merge the gINT Library components into your Library
file.

1. Make a backup copy of your existing library file. By default this is located at:
C:\ Program Files  \ gINT\ libraries \
2. Start gINT and open the library and project file you wish to use with Datgel Monitoring Tool

gINT Add-In.

The opened project and library files are displayed at the top of the gINT Window.
= UTILITIES - Lib Merge/Copy: cgint lib n project files\client\client lib.glb =n=R <" 7
File Help -

INPUT | OUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS UTILITIES |

Repair{Compact Databases Lib Merge{Copy | Print Object Lists | Convert Projects | Extract From ZIP I

3. Select UTILITIES | Lib Merge/Copy.

E= UTILITEES - Lib Merge/Copy: c\gint lib n project files\client\client lib.glb =REER <"
File Help
=]

INPUTI OUTPUT] DATA DESIGN | REPORT DESIGN] SYMBOL DESIGN} DRAWINGS UTILITIES l

Repair{Compact Databases Lib Merge/Copy | Print Object Lists | Convert Projects | Extract From ZIP I

=
Compare Libraries ‘ ® Merge From i~ Copy To
Source Library File J
Target Library File c:\gint lib n project files\clienticlient lib.glb
® Select All s Always Query
" Select Newer " Query on Overwrite
" Select Non-duplicated " Never Query
Avai Source Tables Tables to Merge/Copy
Execute Help

4. Check the bullet that reads Merge From.

5. Inthe Source Library File pane, browse the installation CD for file
Datgel Monitoring Tool lib # ##.glb where #.## is the version number.

6. Check the bullet that reads Select All.
7. Check the bullet that reads Query On Overwrite.

8. Click **! button to move all tables from the Available Source Tables pane on the left to the
Tables to Merge/Copy pane on the right side.

Monitoring Tool gINT Add-In T Datgel
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[E=3) OB 55|

= UTILITIES - Lib Merge/Copy: c\gint lib n project files\client dgd\client lib.glb
File Help

REPORT DESIGN | S5YMBOL DESIGN | DRAWINGS UTILITIES

INFUT | OUTPUT | DATA DESIGN
Repair/Compact Databases  Lib Merge/Copy \ Print Object Lists ] Convert Projects ] Extract From ZIP _

Compare Libraries &+ Merge From  CopyTo

Source Library File [p:p itoring toolgint files'4 monitoring tool lib |
|1.(N5.glh

Target Library File cigint lib n project files\client dgdiclient lib.glb

¢ Select All " Always Query
" Select Newer « 0
~ Select Non-duplicated

Available Source Tables Tables to Merg o
ped | DG_MON_BACKFILL_MATERIAL

DG_MON_BACKFILL_POINTER

DG_MON_BACKFILL_TEXT

LI DG_MON_DISPLACEMENT_ID
DG_MON_PIEZOMETER_REFERENCE_POINT

il DG_MON_PIEZOMETER_SURFACE_COMPLETION
DG_MON_PIEZOMETER_TELESCOPE_LEVEL
DG_MON_PIEZOMETER_TYPE

P73 || DG_MON_TEST_METHOD

Execute Help

9. Click Execute. This process may take several minutes to complete.

Take care to read the overwrite dialog and click Yes if you wish to overwrite the file, ELSE click
No.

Add-Ins

DMT8_Licensing exists. Overwrite?

Yes No Cancel

This will merge in the lookup lists, Add-In menu item, and gINT Rules modules which are all
related to the Tool.

10. Click OK to finish the merge.

gINT(R): appUiilities

Merge/Copy completed

1.6 Merge gINT Project Tables

1. Make a backup copy of your existing project file. By default this is located at:

C:\ Program Files  \ gINT\ projects \
2. Start gINT and open the library and project file you wish to use with Datgel Monitoring Tool.

3. Select DATA DESIGN | Project Database.

Datgel

Monitoring Tool gINT Add-In T
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SelectFi | e > Open Fi |l e toopemyoureurrent pi@jecbfijee ct é

Select Tables > Import Multiple Tables... then browse the installation CD and select the file
Monitoring Tool #. ##.9pj

6. As a minimum, select the following tables to import and click OK.

= Select One or More @

Name Description
MON_BACKFILL Instrumentation/B ackfill Details; D atgel Monitoring Tool, (c) 2009 Datgel Pty Ltd
MON_DISPLACEMENT
MON_DISPLACEMENT_READINGS
MON_MAGNETIC_EXTENSOMETER
MON_MAGNETIC_EXTENSOMETER_BASE_READINGS
MON_MAGNETIC EXTENSOMETER_PROBE
MON_MAGNETIC_EXTENSOMETER_READING DT
MON_MAGNETIC_EXTENSOMETER_READINGS
MON_MAGNETIC EXTENSOMETER SET
MON_PIEZOMETER
MON_PIEZOMETER_AQUIFER Piezometer Aquifer; D atgel Monitoring Tool, (c) 2009 Datgel Pty Ltd
MON_PIEZOMETER_CASING
MON_PIEZOMETER_DIPPER Piezometer Dipper; Datgel Moni Tool, (c] 2009 Datgel Pty Ltd
MON_PIEZOMETER_GROUT_TYPE Piezometer Grout Type: Datgel ring Tool, [c] 2009 Datgel Pty Ltd
MON_PIEZOMETER_PVC_TYPE
MON_PIEZOMETER_READINGS Piezometer readings; D atgel Monit g Tool, [c] 2009 Datgel Pty Ltd
MON_PIEZOMETER_SAND_TYPE
MON_PIEZOMETER_SCREENS
MOMN_POINT_DPTIOMS Monitoring Project Options; D atgel Monitoring Tool, [c] 2009 Datgel Pty Ltd
MON_PROJECT_OPTIONS Monitoring Project Options; D atgel Monitoring Tool, [c] 2009 Datgel Pty Ltd
MON_ROD_SETTLEMENT_GAUGE

MON_ROD_SETTLEMENT_GAUGE_READINGS Rod Settlement Gauge Readings; Datgel Monitoring Tool, [c] 2009 Datgel Pty Ltd

| Ctri+Click or Shift+Click for multi-select

Mark All | oK I Cancel

When prompted with a dialog box, similar to the one below, click OK. This will import
predefined project table data that can be used during data entry.

gINT(R): appDBDesign (sl

Source table property specifies 'Keep Data in Clone'. 4 records have been
imported.

If you chose to edit the data and/or add to it, you will need to ensure that you update your data
template so that any changes/additions are available in all future projects that are cloned from
your data template.

The WATER_STRIKEROGRES&d ROTARY_FLU$a&bles are associated with the operation of
the Monitoring Tool but you may already have similar tables in your project file. However, these
tables are referenced in the Log Report Blocks DG MON WELL INSTALLATION and DG
FLUSH RETURN 7 MM and if you chose not to merge these tables then you may need to
update the field references in these blocks to ensure that the Monitoring Tool works with your
custom project database.

Monitoring Tool gINT Add-In T Datgel
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1.7 Activate License

After installation (and before using the Monitoring Tool Add-in), activate the user license as described in
Chapter 3 of the Datgel Product Licensing System User Guide.

Note: You only need to activate this product when you run the Datgel Monitoring Tool in gINT 8 for the first
time.

Datgel
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2  General Project Tables

2.1 Project

The general project information, such as the ProjectDand ProjectNameshould be recorded on the Project
table.

= e s |
File Additional Modules Edit Format Tools Tables gINT Rules Add-Ins  MNavigation Help

[ S S B

Main Group

Project | Point | Statabsin | Backfl | Monioring Project Optiors | Mo
[Main Group group] Table Help

>

Project ID
Project Title
Location | Somewhere
Client | Datgel
Contractor Datgel
Project Engineer | Datgel
Remark | Some general remark
Elevation Datum AHD
Coordinate System | MGA94
Data File Producer | Dalgel
Data File Recipient | Datgel
Issue Sequence Number 1
Status of Data within 5 ission | 0
File Reference
Date of data production [dd/mm/yyyy] 1/06/2009
AGS Edition Number | 3.1
Depth Log Page (m)| 10
Data Template: DMT 1.05
Dffice

Sample Project

Name=Project_ID. Project identfier/number

2.2 Point

At a minimum, the Pointand Total Deptbf the hole should be recorded on the Pointable. In addition, the
Type East North ElevatigrPlungeand Orientatiodata should also be recorded and the Depth Log Pagalue
should be specified. You may wish to complete the remaining metadata fields for completeness.

Monitoring Tool gINT Add-In i Datgel
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2 INPUT - pAproducts\monitoring toolgint files\1.05\datgel manitoring tool 1.05.gpj: POINT table Library: p\products\monitoring toolgint files\1.05\datgel =2 E=R ==
File Additional Modules Edit Format Tools Tables gINT Rules Add-Ins Mavigation Help
BoE B Hess B8
INPUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES
Main Group | Drilling | Piezometer | Displacement | Lists | AGS | Site Map |
Project Point | SuataMan | Backfl | Monitoring Project Options | Monitoring Paint Options |
[Main Group group] Table Help
>
PointiD Total Type East North Elevation Plunge Orientation Area Date Started Date Contractor
Depth (m) [m) {m) [deg) (deg {dd/mm/ypyy)  Completed
[m) azimuth) [dd/mm/yyyy)
DLD-1 22|DLD 248193.48| 1267464.99 5.50 Area 1 5/06/2008 | 6/06/2008 |Contactor 1
DLD-2 25.4/DLD 248241.34 1267497.67 5.50 Area 1 5/06/2008 | 6/06/2008 |Contactor 1
MEX-1 7.5[MEX 248109.13] 1267415.90 590 Area 1 5/06/2008 | 6/06/2008 | Contactor 1
MEX-2 7.5/ MEX 248167.53| 1267411.54 5.90 Area 1 5/06/2008 | 6/06/2008 |Contactor 1
MSET-1 0[MSET 248088.04| 1267376.71 5.90 Area 1 5/06/2008 | 6/06/2008 |Contactor 1
MSET-2 0[MSET 248123.40] 126736232 590 Area 1 5/06/2008 | 6/06/2008 | Contactor 1
Piczo EPIE-1 9.5|PIE 248039.83| 1267367.24 3.48 Area 1 5/06/2008 | 6/06/2008 |Contactor 1
Piezo EPIE-2 9.5(PIE 248136.42 1267409.37 361 Area 1 5/06/2008 | 6/06/2008 |Contactor 1
Piezo 5P-1 4.9[PIE 247949.38] 126734712 053 Area 1 5/05/2009 | 6/05/2009 | Contactor 1
Piczo 5P-2 15.4|PIE 248055.74| 1267349.66 344 Arca 1 5/05/2008 | 6/05/2008 |Contactor 1
RSG-1 0[RSG 247976.13 1267373.70 5.20 Area 1 5/06/2008 | 6/06/2008 |Contactor 1
RSG-2 0[RSG 248157.04| 126743651 520 Area 1 5/06/2008 | 6/06/2008 | Contactor 1
=
« m 5
Name=Checked_Date ~ | Row7
of 12

2.3 Backfill

The Backfiltable is used to store the installation backfill material details and other associated data for
Piezometer, Deep Datum and Magnetic Extensometer installations.

Enter the Topand Bottondepths for each backfill Materiaype. Where there are multiple piezometer
installations within a single hole, each zone (Topand BottonDepths) of backfill material needs to be
defined in the backfill table.

Should the diameter of the hole reduce with depth, the Telescopeelelfield can be used to represent this.
For each reduction in the diameter the Telescope LewaHould be increased.

For example, the default Telescope Levugl0 and would be used to represent the initial diameter of the
hole. If the diameter of the hole is reduced during the course of drilling, this could be represented in the
backfill by selecting a Telescope Lewafl1 where the Topdepth equals the depth at which the reduction in
the hole diameter occurs. Each subsequent reduction in the diameter of the hole can be represented by
increasing the Telescope Levela maximum of 4.

To add a pointer from the Backfilmaterial to the installation, select an applicable pointer type that
coincides with the telescope level at that depth. For example, if you wanted to show a pointer to the
edge of the Telescope Levklyou would select PointeH and if you wanted to show a pointer to the edge
of the Telescope Le&lyou would select PointeF. If a Pointeis not selected then the Backfilmaterial type
will not be displayed.

IMPORTANT  For Piezometer - to correctly display the installation on the provided log reports, the values
entered in the Topand Bottonfields on the Backfiltable should correspond with the DepthTopRespons&oneand
DeptiBottonResponsgonefields on the Piezometer Scredable.

Monitoring Tool gINT Add-In T Datgel
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File Additional Modules Edit Format Tocls Tables gINT Rules Add-Ins Mavigation Help

e B SR N =R =l
INPUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES
Main Group

Backfil

ST T T
[

Conciete

Grout

Bentonite
Sand
Eentonite
Sand
Eentonite
Sand

B R EEEE

Bentonite

MName=File_Reference. Associated fils reference N

2.4 Monitoring Project Options

The Monitoring Project Opttabte is used to configure the output conditions for the monitoring reports.
The options specified in this table are overridden by a correspondingly defined value in the relevant
monitoring table or on the MonitoringoinOptiongable.

INPUT

Main Group

Name=R5G_Gauge_Displacement_Minimum. Graph scale project level default. Overidden by value on MOM_ROD_SETTLEMENT_GAUGE. If both fields are blank then the min reading rounded to 100 =
mm i used.

The MinmumMonitorinBateTimeScaleand MaximunMonitorinBae TimeScaldfields are used on the provided
monitoring reports to set the minimum and maximum date-time axis extent. If they are not defined then
the minimum and maximum reading values are used to define the date-time axis extent on the reports.

Monitoring Tool gINT Add-In i Datgel
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24.1 Rod Settlement Gauge Options

The RSG Gauge Displacement MiramdiiRSG Gauge Displacement MaXigldsare used to determine the
minimum and maximum displacement axis values for the rod settlement gauge monitoring reports. The
values entered into these fields can be overridden for an individual PointID by specifying a value on the
Rod Settlement Gatajale.

If a minimum and maximum value is not specified in the RSG Gauge Displacement MiramdiRSG Gauge
Displacement Maxinfigids on the Monitoring Projegiti@ngable nor in the respective fields on the Rod
Settlement Gautgble, then the minimum and maximum reading values recorded in the Rod Settlement
Gauge Readintable are used to define the gauge displacement axis extents on the reports.

The RSGFillDisplacement Minimamd RSGFillDisplacement Maxinfiglds are used to determine the
minimum and maximum displacement axis values for the fill materials surrounding the rod settlement
gauge on the monitoring reports. The values entered into these fields can be overridden for an
individual PointID by specifying a value on the Rod Settlement Gatajale.

If a minimum and maximum value is not specified in the RSGFillDisplacement Minimamd RSGFill
Displacement Maxinfiglds on the Monitoring Proj€xptionsable nor in the respective fields on the Rod
Settlement Gautgble, then the minimum and maximum reading values recorded in the Rod Settlement
Gauge Readintable are used to define the fill displacement axis extents on the reports.

2.4.2 Displacement Options

The Displacement Minimamd Displacement Maxinfiglds are used to determine the minimum and
maximum settlement axis values for deep datum and settlement marker monitoring reports. The values
entered into these fields can be overridden for an individual PointID by specifying a value on the
Displacemetdble.

If a minimum and maximum value is not specified in the Displacement Minimamd Displacement Maximum
fields on the Monitoring Project Opttabte nor in the respective fields on the Disphcemertable, then the
minimum and maximum reading values recorded in DisplacemeRieadingtable are used to define the
settlement axis extents on the reports.

2.4.3 Magnetic Extensometer Options

The MEX Displacement Minimamd MEX Displacement Maxinfigiils are used to determine the minimum
and maximum settlement axis values for magnetic extensometer monitoring reports. The values
entered into these fields can be overridden for an individual PointID by specifying a value on the
Magnetic Extensoméabie.

If a minimum and maximum value is not specified in MEX Displacement Minimamd MEX Displacement
Maximurfields on the Monitoring Project Opttabte nor in the respective fields on the Magnetic Extensometer
table, then the minimum and maximum reading values recorded in Magnetic Extensom&eadingtable

are used to define the settlement axis extents on the reports.

2.4.4 Piezometer Options

The Piezometer Water Elevadimimurand Piezometer Water Elevafiaximurfields are used to determine
the minimum and maximum water level axis values for groundwater monitoring reports. The values
entered into these fields can be overridden for an individual PointID by specifying values on the
Monitoring Point Optitadute.

If a minimum and maximum value is not specified in Piezometer Water Elevimmurand Piezometer Water
ElevatioMaximurfields on the Monitoring Project Opttabke nor in the respective fields on the Monitoring
Point Optiortable, then the minimum and maximum reading values recorded in PiezometdReadingtable

are used to define the water level axis extents on the reports.

Monitoring Tool gINT Add-In T Datgel
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2.5 Monitoring Point Options

251 Piezometer Options

The Piezometer Water Elevafimimurnand Piezometer Water Elevafiaximurfields are used to determine
the minimum and maximum water level axis values groundwater monitoring reports for individual
PointID. The values entered into these fields will override any values that may be specified on the
Monitoring Project Opttabte.

If a minimum and maximum value is not specified in Piezometer Water Elevaimimurand Piezometer Water
ElevatioMaximurfields on the MonitoringoinOptiongable nor in the respective fields on the Monitoring
ProjecOptiongable, then the minimum and maximum reading values recorded in PezometeReadingtable
are used to define the water level axis extents on the reports.
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3  Piezometer

Note: A step by step example is provided in sections 9.1 and 9.2.

3.1 Reference Tables

This group of tables contains standard information that is referenced by the other Piezometer tables. It
can be edited to suit the needs of an individual project and, if it is incorporated into your data template,
the information will available in each new project file that is cloned from the new data template.

3.1.1 Aquifers

The Aquifetable is used to record the details of an aquifer that may have been encountered on a
particular project. The name given to the aquifer can then be picked on the Piezometer Scredable.

File Additional Modules Edit Format Teels Tables gINTRules Add-Ins MNavigation Help

Ao W= REY SR CY=NSNENRNE

INPUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES
Piezometer

Aaquifer

ll:ld—!—
[ LI

o
o
i

intermediate

Mame=Itemk.ey. s
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3.1.2 PVC Type

The PVC Typtable is used to define a Codeand the associated metadata for that type of PVC pipe used
in an installation. The Codecan then be picked on the Piezometer Scredable.

File ional Modules  Edit Format Toels Tables gINT Rules Add-Ins  Navigation Help
r-"'D,E e s s B[00

INPUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES
I_ Piezometer I_ I_ I_

FYC Type

3.1.3 Sand Type

The Sand Typtable is used to define a Codeand the associated metadata for each type of sand used in
the backfill of the installation. The Codecan then be picked on the Piezometer Scredable.

_I
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3.1.4 Grout Type

The Grout Typtable is used to define a Codeand the associated metadata for each type of grout used in
the backfill of the installation. The Codecan then be picked on the Backfitable.

Iﬁle i Modules Edit Format Teols Tables gINT Rules Add-Ins Pavigation Help I

= re e e s G e B[ VE — ,—
INPUT " Site Map |
_ Main Group Piezometer

Grout Type

]

| Code s’ ~~  Desepon |
I Pellets

| [Shny |

|

MName=ltemk.ey. -
-

3.1.5 Piezometer Dipper

The Piezometer Dipjiable is used to define a Codeand the associated metadata for each piezometer
dipper used to monitor the installation. The Codecan then be picked on the Piezometer Readitajsle.

Fiezometer Dipper

_I
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3.2 Installation

3.2.1 Piezometer

The general piezometer installation details for each PointID should be entered on the Piezometdupper)
table. As multiple installations can be installed, each individual installation is uniquely identified by its tip
depth (DeptlofTip and by its ID (PiezometéD). See Section 9.1 and 9.2 for examples on how to record a

single pipe installation and multiple pipe installation.

2= INPUT - p:\products\monitaring tool\gint files\1.05\datgel monitaring tool 1.05.gpj: MON_PIEZOMETER table Library: p:\products\monitoring tool\gint files\1.0
File Additional Modules Edit Format Tools Tables gINTRules Add-Ins Mavigation Help

==

5 [ Sla 8 S [] [Ficzo 5P =
INPUT | OUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES
Main Group | Driling P Di Lists | AGS | Site Map

Fizometer | Pieaometer Screers | Fiseometer Casing | Adufer | PVCTupe | SardType | Gout Type | PieeometerDipper |

[Piezometer group]

Table Help

>
Depth | Piezometer | Type | Elevation Reference Stickup @ Elevation Remark Installation Flushed Prior to Surface Use Top Suppress
of Tip of Tip Point of Ref | Reference Date Inzstall Completion Access  Average
(m) (m) Point Point (dd/mm/yyyy Tube Base
[m) (m) hhmmss) Elevation Calc
q1 SP | 39 pvetec | 089 1.48 | B/05/2009 | Mot Recorded | Steel Monument o |
* \ | \ | \ \ | O 1 O |
< m »
Name=\"/_Barometric_Pressure. VW Piezo Barometric Pressure

- Row 1
of 1

| [Piezometer Readings]  Piezo 5P-1.4.5.1

Table Help

Date Time ‘Water Vibrating Temper Base ‘Water Water Water Pore Change Change Remark Dipper ID | ~
(dd/mm/yyyy hhmmss) Depth Wire ature Reading dbgl Head Elevation Pressure Elevation Elevation 7
Reference| Reading | [DegC) [m] [m) [m]) [kPa) From From B
Point [Hz2 x Base Previous
(m) 107-3) (m) (m)
10/05/2009 7:00:00 AWM 2.80 1.91 3.63 -0.28 356 0.00 This point is not
24/05/2009 2:00:00 PH 280 1.91 3.63 -0.28 356 0.00 0.00
25/05/2009 2:20:00 PM an O 222 334 -0.57 328 -0.29 -0.29
30/05/2009 9:50:00 AWM 314 O 225 33 -0.60 325 -0.32 -0.03
1/06/2009 10:00:00 AW 312 O 223 334 -0.57 328 -0.29 0.03
1/06/2009 1:05:00 PM 314 O 225 332 -0.59 326 -0.31 -0.02
2/06/2003 7-15:00 AWM 313 O 224 329 -0.62 323 -0.34 -0.03
270672009 1:30:00 PHM 316 O 227 329 -0.62 323 -0.34 0.00
2MNE20NG 4-N0-NN P a0 [m] FETINETT neR a2 n na7 -nna i
< m 3
Row 1
of 144

3.2.2

Piezometer Screen and Response Zones

The Piezometer Scredable is used to store the installation screen and the response zone information
and associated metadata, such as installation material types that are used.

The installation screen section (Depth Top Screand Depth Base Scrg¢eefers to the top and bottom
depths of piezometer that allows for the free movement of groundwater into the well. The response
zone (Depth Top Response Zamak Depth Base Response Y mafers to the top and bottom depths of the

backfill medium that surrounds the screened section.

IMPORTANT  To correctly display the installation on the provided log reports, the values entered in the
DepthropResponsgoneand DeptiBottonResponsgondields on the Piezometer Screetable should match the

Topand Bottonfields on the Backfiltable.
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=
ﬁleMditmnﬂModMﬁEdﬂFum\leoﬂkTaMsngﬂmst»hNawgatwnHﬂp
[ E Piezo SP-1

Piezometer

Fiezometer Screens

Wfﬁffﬁfﬁfﬁﬁffg
i

l

MName=Fiezameter_|D.

3.2.3 Piezometer Casing

If the drill casing has been left in the ground as part of the installation, the information is recorded on
the Piezometer Castatle by entering the bottom depth (and telescope level if applicable) of the casing.

=

ﬁleMdhmndMndMsﬁﬁlFunnleoﬂkTiMsngmmst—hMamgitmanp

Piezometer

Piezometer Casing

Name-ltemKey. Telescope number A
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3.3 Monitoring Re adings

The ground water monitoring readings are recorded on the Piezometdlower) table by entering the date
and time when the monitoring occurred in the Date Timéeld and the water depth in the Water Depth

Reference Pofigld.

2= INPUT - pAproducts\monitoring toolgint files\1.05\datgel monitaring tool 1.05.gpj: MON_PIEZOMETER table Library: p:\products\maonitaring taol\gint files\1.0 =2 EcB <=
File Additional Modules Edit Format Tocls Tables gINTRules Add-Ins Navigation Help
r e [EE W= ) [ (2 |Piezo 5P-1 =]
INPUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES |
Main Group | Drilling  Pi | pi | Lists | AGS | Site Map |
Pigzometer | Fiezometer Screens | Piezometer Casing | Aquifer | PYCType | SandType | GroutType | Piszometer Dipper |
[Piezometer group] Table Help
>
Depth Piezometer Type Elevation Reference Stickup Elevation Remark Installation Flushed Prior to Surface Use Top Suppress
of Tip D of Tip Point of Ref | Reference Date Install Completion Access  Average
(m) (m] Point Point (dd/mmlyypy Tube Base
[m) (m) hhmmss) Elevation Calc
| 450 SP -3.91 | pvc-toc 0.89 1.48 6/05/2009 | Not Recorded | Steel Monument [m]
* O m|
« m r
Name=\"/_Barometric_Pressure. VW Piezo Barometric Pressure s ‘ Row1
of 1
| [Piezometer Readings]  Piezo 5P-1.4.5.1 T able: Help
Date Time Water | Vibrating | Temper | Base  Water Wale: Water  Pore | Change  Change Remark Dipper ID | -
(dd/mm/yyyy hhmmss) Depth Wire ature Reading dbgl Head Elevation Pressure Elevation Elevation
Reference| Reading | [DegC) [m] [m) [m]) [kPa) From From
Point [Hz2 x Base Previous
(m) 107-3) (m) (m)
10/05/2009 7:00:00 AWM 2.80 1.91 363 -0.28 356 0.00 This point is not
24/05/2009 2:00:00 PH 2.80 1.91 3.63 -0.28 35.6 0.00 0.00
26/05/2009 2:20:00 PM an O 222 334 -0.57 328 -0.29 -0.29
30/05/2009 9:50:00 AWM 314 O 225 33 -0.60 325 -0.32 -0.03
1/06/2009 10:00:00 AW 312 O 223 334 -0.57 328 -0.29 0.03
1/06/2009 1:05:00 PM 314 O 225 332 -0.59 326 -0.31 -0.02
2/06/2009 7:15:00 AM 313 O 224 329 -0.62 323 -0.34 -0.03
2/06/2009 1:30:00 PM 316 O 227 329 -0.62 323 -0.34 0.00
2MNE2009 4-N0-NN P ERT] [m] FETINETTS ncR 20 na7 -nna ke
« m 3
a Row1
of 144

If the recorded result is inferred to be a static level, check the Statidield and the reading value will be

displayed on the log report, in the column header area.

22 INPUT - phproductsimenitoring toolgint files\1.05\datgel monitoring tool 1.05.gpj: MON_PIEZOMETER table Library: p:\preductsimonitoring toolgint files\1.0 EI @
File Additional Modules Edit Format Tools Tables gINT Rules Add-Ins MNavigation Help
EAERENE| M= NN = N =]
INPUT | DUTPUT | DATA DESIGH | REPORT DESIGH | SYMBOL DESIGN | DRAWINGS | UTILITIES |
Main Group | Drilling  Piezometer | Displacement | Lists | AGS | Site Map |
Piezometer | PiezometerScresns | Piezometei Casiig | Aquifer | PYCTupe | SandType | GroutTpe | Piezometer Dipper |
[Piezometer group] Table Help
b
Depth | Piezometer <= Surface Use Top Suppress Do Not | Manually | Water Base Base Date Start Base Date End Date Stopped as
of Tip [[+] Completion Access Average Calculate Set Base Elevation (dd/mm{yyyy hhmm) = (dd/mm/yyyy hhmm) Monitoring 1]
(m) Tube Base Readings (m) [dd/mm/yyyy hhmmss] itc
Elevation Calc
| 450 Steel Monument 0 0 (] -0.28| 10/05/2009 7:00:00 | 24/05/2009 2:00:00
* ] L] ] [l
4 I *
Mame=Depth. Distance of monitoring point from HOLE_ID - ‘ F!c;vﬂ
of
| [Piezometer Readings]  Fiezo 5P-1.4.5,1 T able Help
€= Processed Processed Checked Checked Date Approved Date Approved | Reading Display  Static File -
[dd/mm/yyyy hhmmss]) Logged y Date By (dd/mm/yyyy | [dd/mm/yyyy hhmm) By Status | On Log Reference
By (dd/mmipyyy) hhmm)
10/05/2009 7:00:00 AM |LB PB 10/05/2003 CB 10/05/2009 30/07/2009 AB 3 O
2470572009 2:00:00 PM |LB PB 24/05/2009 CB 2470572009 30/0772009 AB 3 O O
25/05/2009 2:20:00 PM |LB PB 25/05/2009  CB 25/05/2009 30/07/2009 AB 3 O
30/05/2009 9:50:00 AM |LB PB 30/05/2003 CB 30/05/2009 30/07/2009 AB 3 O O
1/06/2009 10:00:00 AM |LB PB 1/06/2009 CB 1/06/2009 30/0772009 AB 3 O O
1/06/2009 1:05:00 PH  |LB PB 1/06/2009 CB 1/06/2009 30/07/2009 AB 3 O O
2/06/2009 7:15:00 AM  |LB PB 2/06/2009 CB 2/06/2009 30/07/2009 AB 3 O O
2/06/2009 1:30:00 PH  |LB PB 2/06/2009 CB 2/06/2009 30/07/2009 AB 3 O O
2/06/2009 4:00:00 PH  [LB PB 2/06/2009 |CB 2/06/2009 30/07/2009 AB 3 1 1 i
4 m 3
- Fow 1
af 144
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3.3.1 Base Readings

The base field value can be set in two ways:

1. Automatically. If a recorded result is the initial reading for that piezometer installation, you can
check the Basefield on the Piezometdlower) table to indicate this and the base reading will be
displayed in the applicable Basevalue fields on the Piezometgupper) table. If you check more
than one reading as the base reading, then the value displayed in the Basefield will be an
average of these readings.

2. Manually. If you wish to manually record the base values of the installation, then check the
Manually Set Bageld on the Piezometgupper) table and enter this data into the base value
fields. If you want to calculate these values, then leave these fields blank and d o ndheck the
Manually Set Bafseld.

2 INPUT - p\products\monitoring toolgint files\1.05\datgel monitoring tool 1.05.gpj: Men_piezometer_readings table Library: p:\productsi\monitoring toclgint EI@
File Additional Modules Edit Format Tools Tables gINT Rules Add-Ins  Nawvigation Help
S E eSS E L Feose =
INPUT | DUTFUT | DATA DESIGN | REFORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES |
Main Group | Drilling  Pi | D:i: | Lists | AGS | Site Map |
Piszometer | Piezometer Scresns | Piszometer Casing | Aquifer | PYCType | SandType | GrowtType | Piezometer Dipper |
[Piezometer graup] Table Help
b
Depth Piezometer <= Surface Use Top |Suppress Do Mot | Manually  Water Base Base Date Start Base Date End Date Stopped R
of Tip D Completion Access | Average Calculate SetBase  Elevation | (dd/mm/yyyy hhmm) | (dd/mm/yyyy hhmm] Monitoring e
[m) Tube Base Readings [m) (dd/mm/yyyy hhmmss) a
Elevation | Calc s
4501 Steel Monument O O O 272 10/05/2008 7:00:00 | 24/05/2003 2-00:00
* | | | ||
« m »
Name=Depth. Distance of monitoring point from HOLE_ID . ‘ Flow 1
of 1
‘ [Piezometer Readings]  Piezo SP-1.4.5.1 7.2ble Help
Date Time <= Processed | Processed | Checked Checked Date Approved Date Approved | Reading Display | Static File -
(dd/mm/ypyy hhmmss) | Logged By Date By (dd/mm/ygpy | (dd/mm/yyyy hhmm] By Status | On Log Relerence
By [dd/mm/yyyy) hhmm)
10/05/2009 7:00:00 AM (LB PB 10/05/2009 |CB 10/05/2009 30/07/2009 AB 3 O
24/05/2009 2:00:00 PM (LB PB 24/05/2009 |CB 2470572009 30/07/2009 AR 3 O O
2570572009 2:20:00 PM (LB PE 25/05/2009 |CB 25/05/2009 30/07/2009 AR 3 O
30/05/2009 9:50:00 AM (LB PB 30/05/2009 |CB 30/05/2009 30/07/2009 AB 3 O O
1/06/2009 10:00:00 AM (LB PB 1/06/2009 CB 1/06/2009 30/07/2009 AR 3 O O
1/06/2009 1:05:00 PM (LB PE 1/06/2009 CB 1/06/2009 30/07/2009 AR 3 O O
2/06/2009 7:15:00 AM (LB PB 2/06/2009 CB 2/06/2009 30/07/2009 AB 3 O O
2/06/2009 1:30:00 PM (LB PB 2/06/2009 CB 2/06/2009 30/07/2009 AR 3 O O
2/06/2009 4:00:00 PM (LB PE 2/06/2009 CB 2/06/2009 30/07/2009 AR 3 O O
3/06/2009 8:00:00 AM (LB PB 3/06/2009 CB 3/06/2009 30/07/2009 AB 3 O O
Ararannn 1ac.an e lin nn Asmcaannn | en Ainriannn An a7 mnnn an A =) =) X
4 m s
Current temperature reading. C1 (Deg CL: If nothing is given the value on the Piezameter table is used for the Vi piszoemeter calculation Hfuml
of

3.3.2 Top Access Tube Elevation Reference Point

If the groundwater level is to be monitored from the top of the piezometer installation, the elevation level
of which may change over the course of the monitoring period, then you should check the UseTopAccess
TubeElevatiofield on the Piezometdupper) table to calculate the Water Elevatifield. A typical scenario
where you would wish to check this field would be for a piezometer installation on a land reclamation
project.

IMPORTANT If you check UseTopAaessTubeElevatiofield on the Piezometgupper) table then you must
first enter the survey information on the Displacemeifiables.

If the UseTopAccesS ubeElevatiofield on the Piezometdupper) table is checked then the selected
Monitoring PolBton the Displaceme(upper) table for the PointID must be Top Access Tube. The Type
would be MSET. The survey data is then entered on the Displaceme(iower) table.
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&2 INPUT - péipraducts\manitaring tool\gint files\1.05\datgel monitaring tool 1.05.gpj: MON_DISPLACEMENT table Library: p\productsimonitoring taohgint files\l | = || =1 |[wew]
File Additional Modules Edit Format Tocls Tables gINTRules Add-Ins Navigation Help
B EE eSS [ 2 [Pieza 5Pt Bl
INPUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES |
Main Group | Driling | Piezometer Displacement | Lists | AGS | Site Map |
Displacement | Rod Settlement Gauge | Magnetic Extensometer | Magnetic Estensometer Set__ | Magnetic Estensometer Piobe |
[Displacement group] Table Help
>
Monitoring PointlD | Short ID Type Rod Description Rod Rod Concrete | Concrete Concrete  Deep Datum Deep -
Stickup Depth  Dimension| Dimension  Depth Pipe Depth | Datum Pipe
(mm) (mm] {mm) Type [mm) m) Stickup
(m)
Ground
Top Access Tube MSET
x -
« i r
- Fow1
of2
| [Displacement Readings]  Piezo SP-1.Ground Table Help
Date/Time Stage Bench Back Heightof Front F4 Change Change X Change Change Y Chan -
[dd/mm/yyyy hhmm] Mark Z Sight Instrument Sight [m)] ZFrom  ZFrom [m) X From X From [m]) ge Y
[m] [m) [m]) [m] Base |Previous Base Previous From
(mm) [mm) (mm) [mm) Base
1040572009 7:00:00 AWM 5.100 1.000 0,600 0.980 5120 ¥
24/05/2009 2-00:00 PM 5100 1.010 0600 D990 5120 -7 1]
25/05/2009 2:20:00 PM 5.100 1.000 0,600 0.960 5140 13 20
3040572009 9:50:00 AWM 5.100 0.930 0,600 0.950 5140 13 0
1/06/2009 10:00:00 AM 5100 1.000 0,600 D950 5150 23 10
1/06/2009 1:05:00 P 5100 0.980 0,600 0.930 5150 23 1]
270642009 7:15:00 AWM 5.100 0.970 0,600 0D.960 5.110 17 -40
2/06/2009 1:30:00 PM 5100 0.980 0,600 D940 5140 13 a0 il
PP —— M Ut T B - o 3
Row 1
of 144

By checking the UseTopAccesd ubeElevatiofield, the Water Elevation value is calculated by using the Z
field value on the Displaceme(ibwer) table that was recorded at the most closely corresponding
Date/Time to the monitoring result.

If the UseTopAccesS ubeElevatiofield on the Piezometdupper) table is unchecked, the value in the
Elevation Reference Hi@id is used to calculate the Water Elevatifield.

3.3.3 Vibrating Wire Piezometer Readings

In addition to the steps detailed in Section 3.2 the Typeshould be set as EPIE and the remaining
Vibrating Wire Fields on the Piezometdupper) table should be completed, as illustrated below:

Depth | Piezometer| <= W' W' YW Factory W Y Zero YW Pressure W W Y Default File
of Tip 1D Serial | Rating | Maximum Zer B arometric Prior Coefficient Temp Temp Current Reference
[m]) Mumber| [kPa] | Pressure Reading Pressure Installation | [kPa/kHz2 x10°-3] Prior Installation  Coefficient Temperature
[kFPa) [kHz2) [mbar] [Hz2 x 10°-3) [DegC) [kPa/DeqC) [DeqC)
6.00|1 4224 350 9535 1013 9529 0.0752 20 0.0845 20
Where VW Zero Pribrstdlation = Fo
VW Pressureoefficient = Ce

VW TemperaturedPnstallation To
VW Temperature Coefficient Cr
VW Default Current Temperature T,

Note: The VW Default Current Tempenraaluie is only used in the vibrating wire calculation if a Temperature
reading has not been recorded on the Piezometgtower) table.

The following formula is used to calculate the Pore Pressure for vibrating wire piezometers:
0="Q 'Q g8+ Y ¥ #bv

Where P = Pressure (kPa)

Fo = Zero reading prior to installation (Hz* x 107%)
Fy = Current piezometer reading (Hz x 107°)
Ce = Pressure coefficient (kPa / Hz* x 10°°)
Cr = Temperature Coefficient (kPa/ C)
Monitoring Tool gINT Add-In T Datgel
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T, = Current temperature reading ( C) ]
To Zero temperature reading prior to installation ( C)

Each Vibrating Wire ReadiRg and the Temperatui@;) record should then be recorded on the Piezometer
(lower) table.

= INPUT - pi\preducts\moenitoring toel\gint files\1.05\datgel monitoring tool 1.05.gpj: MOMN_PIEZOMETER table Library: p:\products\menitering tool\gint files\1.0 == =
File Additional Modules Edit Format Teels Tables gINT Rules Add-Ins  Navigation Help
] =
DRAWINGS | UTILITIES
Main Group | Driling  Piezometer [ Displacement | Lists | AGS | Site Map |
Piczometer | Piezometer Soreens | Piezometer Casing | Aquifer | PYCType | SandType | GrowtType | FiezometerDipper |
[Piezometer group] Table Help
<= V' V' Vw Factory V' Vw Zero VW Pressure V' V' Vw Default File
Serial Rating Maxi Zero B i Prior Coeffici T T Current Reference
Humber [kPa] Pressure | Reading Pressure | Installation | [kPa/kHz2 x107-3) | Prior || i Coeffici T
(kPa) (kHz2) [mbar) [Hz2 x 10™-3) [(DegC) (kPa/DegC) (DegC)
4224 350 9535 1013 9529 0.0752 20 0.0845 20
] . ] »
Name=Depth. Distance of monitaring point from HOLE_ID - Row 1
af 1
| [Piezometer Readings]  Piezo EPIE-16,1 T able Help
Date Time Water Vibrating Temper  Base Water Water Water Pore Change Change Remark Dipper ID | -
(dd/mm/ypyy hhmmss) Depth Wire alure |Reading dbgl  Head Elevation Pressure Elevation Elevation 3
Refi Reading (DegC) [m) [m) [m) kPa) From From -
Paint Hz2 x Base  Previous
[m) 107-3) [m) [m)
10/05/2009 7:00:00 AM 9269 799 1.99 -4.51 196 0.51
|| 24/05/2009 2:00:00 PM 9146 19 893 293 -5.45 287 -0.43 -0.94 This point is not
2570572009 2:20:00 PM 9192 18 857 257 -5.09 252 -0.07 0.36
30/05/2009 9:50:00 AM 9221 O 8.36 236 -4.88 232 0.14 0.21
1/06/2009 10:00:00 AM 9233 O 827 227 -479 223 0.23 0.09
1/06/2009 1:05:00 PM 9231 O 828 228 -4.80 22.4 0.22 -0.01
2/06/2009 7:15:00 AM 9240 O 822 222 -4.74 21.7 0.28 0.06
2/06/2009 1:30:00 PM 9222 O 835 235 -4.87 231 015 -013
2/06/2009 4:00:00 PM 9214 ! 84l 24 -493 237 0.09 -0.06 S2
< 1 ] v
- Fow1
of 144

3.4 Output

3.4.1 Output Options

In addition to the options mentioned in Section 2.4.4 and Section 2.5.1, you can select which of the
groundwater monitoring results you want to display on the included log reports by checking the Display
on Lodield.
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&= INPUT - p:\productsimonitoring toofgint files\1.03\menitoring tool 1.03.gpj: MON_PIEZOMETER table Library: p:\productsimenitoring toohgint files\1.03\menit | = [ = |5
File Additional Modules Edit Format Tocls Tables gINT Rules Add-Ins Mavigation Help
AN e VY = AP | e =]
INPUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES
Main Group | Driling  Piezometer [ Displacement | Lists | 4GS | Site Map |
Ficzometer | Piesometer Screers | Piseometer Casing | Adufer | PVCTpe | SardType | Gout Type | PieeometerDipper |
[Piezometer group] Table Help
>
Depth Piezometer Type Elevation Reference Stickup Elevation Remark Date Installed = Flushed Prior to Surface Use Top Suppress
of Tip of Tip Point of Ref | Reference [dd/mm/pyyy Install Completion Access Average
(m) [m] Point Point hhmmss) Tube Base
[m) (m) Elevation Calc
1 SP 0.14/pvctoc | 0.89) 5.53 | 6/05/2009 | Mot Recorded | Steel Monument | o |
* \ O | O |
4 . ] +
MName=Depth. Distance of monitoring point fram HOLE_ID - F\ufv: 1
o
| [Piezometer Readings]  Piezo SP-1.4.5.1 Table Help
Date Time €= Processed Processed Checked Checked Date Approved Date Approved Reading Display  Static File -
[dd/mm/yyyy hhmmss) Logged By Date By (dd/mm/yyyy | (dd/mm/yyyy hhmm) By Status | On Log Reference 1
By (dd/mmiyyyy) hhmm] L4
10/05/2009 7:00:00 AM (LB PB 10/05/2009 CB 10/05/2009 30/07/2003 AB 3 O
2470572009 2:00:00 PM (LB PB 24/05/2009 CB 2470572009 3040772009 AB 3 O O
25/05/2009 2:20:00 PM (LB PB 25/05/2009 CB 25/05/2009 3040772009 AB 3 O
30/05/2009 9:50:00 AM (LB PB 30/05/2009 CB 30/05/2009 30/07/2009 AB 3 O O
1/06/2009 10:00:00 AM (LB PB 1/06/2009 CB 1/06/2009 30/07/2009 AB 3 O O
1/06/2009 1:05:00 PH (LB PB 1/06/2009 CB 1/06/2009 3040772009 AB 3 O O
2/06/2009 7-15:00 AM (LB PB 2/06/2009 CB 2/06/2009 30/07/2009 AB 3 O O
2/06/2009 1:30:00 PH (LB PB 2/06/2009 CB 2/06/2009 30/07/2009 AB 3 O O
2/06/2009 4:00:00 PH (LB PB 2/06/2009 CB 2/06/2009 3040772009 AB 3 O O
3/06/2009 8:00:00 AM (LB PB 3/06/2009 CB 3/06/2009 30/07/2009 AB 3 O O
3/06/2009 1:05:00 PH [LB PB 3/06/2008 |CB 3/06/2009 30/07/2003 AB 3 O O 2
« [ i ]
- Row 1
| ofras

3.4.2

Output Reports
Logs | MON PIEZOMETER INSTALLATION LOG
Graphic Table | MON PIEZOMETER READINGS
Graphs | MON HYDROGRAPH A3L
Graphs | MON HYDROGRAPH A4L
Graphs | MON HYDROGRAPH A4P
Graphs | MON PIEZOMETER FILL VERSUS TIME PLOT
Graphs | MON PIEZOMETER VERSUS TIME PLOT

= =4 =4 -4 4 -4 - A

Graphic Table | MON PIEZOMETER READINGS FIELD SHEET
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A

4.1 Overview

The displacement tab stores and calculates data related to Settlement Markers, Deep Datum, and Total
Station installations. The database structure allows multiple instruments for one PointID to be manage,
where each instrument has a unique PointID i Monitoring PointID combination.

Displacement

4.2

Note: A step by step example is provided in section 9.3

Deep Datum

42.1

The Displacemetdble is used to store the details of the Deep Datum installation for a PointID. The
selected Monitoring PdiDbn the Displaceme(upper) table should be Instrument and the Typeshould be
DLD. The Rod StickyRod DepiiConcrete Dimgionand Concrete Defiklds are not applicable to a Deep
Datum installation and should be left blank.

Installation

2= INPUT - pi\products\menitering tool\gint files\1.03\menitering teel 1.03.gpj: MON_DISPLACEMENT table Library: p:\products\menitering tool\gint files\1.03\mon
File Additional Modules Edit Format Tools Tables gINT Rules Add-Ins  Mavigation Help

= N N =N = N s ~ IR =

INFUT | DUTPUT | DATA DESIGH | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES |

Main Group | Drilling | Piezometer Di | Lists | AGS | Site Map |

Displacement | Fod Selfement Gauge | Magnetic Extensometer |

E= e =2

Magnetic Extensometer Set | Magnetic Exlensometer Probe |

[Displacement group]

Table Help
¥

Monitoring PointlD | Short ID Type Rod Description Rod Rod Concrete | Concrete Concrete  Deep Datum = Deep Datum
Stickup Depth  Dimension Dimension Depth Pipe Depth Pipe Stickup
[mm) [mm) [mm] Type [mm] [m) (m)
Rod Description 21.5 1.2

m 1 -

4

.

0

MName=Itemk.ey. Monitaring PointlC

Fow 1
of 1

| IDi Read DLD-11 Table Help
Date/Time Stage Bench Back Heightof Front F4 Displacement Displacement X Displacement Displacem -
(dd/mm/yyyy hhmm) Mark Z | Sight Instrument | Sight [m] z hange Z [m] ent
m | (m [m] m) (mm) (mm) (mm] Change X
(mm) | &
170772009 11:00:00 AM 5.100| 1.000 0.600| 0.980, 5120 1}
2/0772009 1:15:00 PH 5.100) 1.010 0.600 0.990 5120 1] 0
3/07/2009 9:00:00 AWM 5.100| 1.000 0.60D0| D.960, 5140 20 20
470772009 9:00:00 AWM 5.100| 0.990 0.600| 0.950, 5140 20 0
5/07/2009 9:00:00 AM 5.100, 1.000 0.600 0.950 5.150 30 10
670772009 9:00:00 AWM 5.100| 0.980 0.600| 0.930 5150 30 1]
770772009 9:00:00 AWM 5.100| 0.970 0.600| 0.960 5110 -10 -40
870772009 9:00:00 AWM 5.100| 0.980 0.600| 0.940/ 5140 20 30 -
« n r
Row 1
of 23

The installation details about the Deep Datum monitoring installation are then entered into the Deep
Datum Pipe Depleep DatuRipe StickypeeDatunOutePipe Depthnd Deep Datufuter Pipe SticKiglds
on the Displaceme(upper) table. The Rod StickyRod DepttConcrete Dimensamd Concrete Depfields are
not applicable to a Deep Datum installation and should be left blank.

Monitoring PointlD <= Deep Deep Datum Deep Datum Deep Datum Inztallation Date Remark
Datum Pipe | FPipe Stickup Outer Pipe Outer Pipe [dd/mm/yyyy hhmm)
Depth [m] Depth Stickup
(m] [m) (m]
215 1.2 Fi 1.1 30/06/2009 DOuter 75 mm dia. galvanised steel pipe:
11:15:00 AM Inner 27 mm dia. pipe
Monitoring Tool gINT Add-In T Datgel
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4.2.2 Monitoring Readings

The deep datum monitoring readings are recorded on the Displaceme(libwer) table by entering the date
and time when the monitoring occurred in the Date Timéeld and the survey information in the Bench Mark

Z, the Back Sitehe Front Sitand (optionally) the Height of Instruméalds.

You may also enter data in the Zfield and leave the Bench Mark Back SiteFront Sitand Height of Instrument

fields blank.

2= INPUT - p\products\menitaring tool\gint files\1.03\monitering tocl 1.03.gpj: MON_DISPLACEMENT table Library: pA\products\menitoring tool\gint files\1.03\mon
File Additional Modules Edit Format Tools Tables gINTRules Add-Ins  Navigation Help
A S S IS =N N = Y = I ]

INFUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES |

E=8 N (=)

Main Group | Driling | Piezometer Displacement  Lists = AGS | Site Map]

Displacement | Rod Seltlement Gauge | Magnetic Extensometer | Magnetic Eslensameter Set | Magnetic Estensometer Piobe |

[Displacement group]
»

Table Help

Monitoring PointlD | Short ID Type Rod Description Rod Rod Concrete Concrete Concrete Deep Datum  Deep Datum
Stickup Depth  Dimension| Dimension  Depth Pipe Depth | Pipe Stickup
[mm) [mm) [mm] Type [mm] [m) [m)
m 1 DLD | Rod Description 215 12
x
« s
Name=ltermkey. Monitaring PointlD F\IJFV\;T
o

| i Readings]  DLD-1.I Tabl Help
Date/Time Stage Bench Back Heightof Front F4 Digplacement Displacement X Displacement Displacem -
(dd/mm/yyyy hhmm]) Mark Z Sight Instument Sight [m] z hange Z [m]) ent
m  (m m) m) (mm) [mm] (mm) Change X
(mm) =
1/0772009 11:00:00 AWM 5.100 1.000 0,600 0980 5.120 L1}
2/07/2009 1:15:00 PH 5.100 1.010 0,600 0990 5.120 L1} o
3/07/2009 9:00:00 AWM 5100 1.000 0,600 D960 5140 20 20
470772009 9:00:00 AWM 5.100 0.990 0,600 0950 5.140 20 o
5/07/2009 9:00:00 AWM 5.100 1.000 0,600 0950 5.150 30 10
67072009 9:00:00 AM 5100 0.980 0600 D930 5150 30 o
770772009 9:00:00 AWM 5.100 0.970 0,600 0960 5.110 -10 -40
8/07/2009 9:00:00 AWM 5.100 0.980 0,600 0.940 5.140 20 30 -
4 m »
Fawe 1
of 23

The Zand Displacemetvalues are calculated based on the monitoring readings and the Displacement

Chang# field value is calculated from the base field value.

4221

The base field value can be set in two ways:

Base Reading

1. Automatically. If a recorded result is the initial reading for that deep datum installation, you can
check the Basdfield on the Displaceme(lower) table to indicate this and the base reading will be
displayed in the applicable Basevalue fields on the Displaceme(upper) table. If you check more

than one reading as the base reading, then the value displayed in the Basefield will be an

average of these readings.

2. Manually. If you wish to manually record the base values of the installation, then check the
Manually S8asefield on the Displaceme(upper) table and enter this data into the Base value
fields. If you want to calculate these values, then leave these fields blank and d o ncldetk the

Manually S8asefield.
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2 INPUT - pi\productsimanitoring toolgint files\1.05\datgel manitoring tool 1.05.gpj: MON_DISPLACEMENT table Library: pi\productsimanitaring toolgint files\l | = || =1 |[weaw]
File Additional Modules Edit Format Tools Tables gINTRules Add-Ins Nevigation Help

5|

SYMBOL DESIGN | DRAWINGS | UTILITIES
Main Group m Piezometer  Di Lists | AGS | Site Map

Displacement | Fod Setlemert Gauge | Magnetic Extensometer | Magretic Exlensometer Set | Magreti E Frobe |

[Displacement group] Table Help
>

Monitoring PointiD <= Remark Base X BaseY BaseZ Base Date Start Base Date End Manuallp  Date Stopped
(m) [m]) [m]) (dd/mm/yyyy hhmm] | [dd/mm/ypyy hhmm] Set Base Monitoring
[dd/mm/yyyy]
Duter 75 mm dia. galvanised steel pipe; 5.120 1/07/2009 11:00:00 | 2/07/2009 1:15:00
~ | Inner 27 mm dia. pipe AM PH O
* O

< m b

Name-ltemkey. Monitoring PointiD Fow 1

of 1

I[D' Readings]  DLD-1.1 Table Help

Date/Time <= Logged Processed Processed Checked Checked Date Approved Approved Date Reading File -
[dd/mm/yyyy hhmm] Base By B ate By [dd/mm/Zyyyy) By [dd/mm/yyyy hhmm] =~ Status Relerence 7
Reading [dd/mm/yyyy]

1/07/2009 11:00:00 AWM LB cB 1/07/2009 AB 25/07/2009 3 ‘ ‘
2/07/2009 1:15:00 PM LB DG 2/07/2009 W
3/07/2009 9:00:00 AWM O LB CcB 3/07/2009
470772009 9:00:00 AWM O LB DG 410742009
570772009 9:00:00 AM O LB CcB 5/07/2009
670772009 9:00:00 AWM O LB DG 6/07/2009
770772009 9:00:00 AWM O LB CB 710772009
8/07/2009 9:00:00 AM O LB DG 8/07/2009 AB 25/07/2009 3 i

= smmmees 2 am an a0 = — —— = -

- Row 1
of 22

4.3 Output

4.3.1 Output Options

The Displacement Minimamd Displacement Maxinfiglds are used to determine the minimum and
maximum settlement axis values for each Monitoring Pointb the deep datum monitoring reports. The
values entered into these fields override the values specified on the Monitoring Project Opttable.

If a minimum and maximum value is not specified in the Displacement Minimamd Displacement Maximum
fields on the Displacemetable nor in the respective fields on the Monitoring Project Opttabte, then the
minimum and maximum reading values recorded in DisplacemeReadingtable are used to define the
settlement axis extents on the reports.
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= INPUT - p:\products\monitaring tool\gint files\1.05\datgel monitaring tool 1.05.gpj: MON_DISPLACEMENT table Library: p\products\monitoring toohgint files\l [ || =1 |[uEal]
File Additional Modules Edit Format Tools Tables gINTRules Add-Ins Mavigation Help

5|

UTILITIES

Main Group - Piezometer  Di Lists | AGS m
Displacement Rod Settlement Gauge tagnetic Extensometer Magnetic Extensometer Set Magnetic Extensometer Probe
[Displacement group] Table Help |
>
Monitoring PointlD <= Date Stopped Monitoring Reason Stopped Monitoring Remark Displ: Displ; File
Manually [dd/mmZpyyy] Monitoring Minimum Maximum Reference
Set Base (mm) [mm]
< |
® O
‘ n 3
Name=ltermkey. Monitaring PaintlD - Fow1

of 1

|"" Readings]  DLD-1.] TahIEHalpl

Date/Time Stage Bench Back Heightof Front 2z Change Change x Change Change Y Chan | »
(dd/mm/ypyy hhmm) Mark Z Sight Instrument Sight [m) ZFrom Z From [m) X From X From [m) geY
m  (m) m) [m) Base | Previous Base Previous From
(mm] | [mm] (mm] | (mm) Base | =
170772009 11:00:00 AWM 5.100 1.000 0,600 0.980 5120 L1}
270772009 1:15:00 PM 5100 1.010 0600 0990 5120 0 1]
370772009 9:00:00 AWM 5.100 1.000 0,600 0.960 5.140 20 20
4707/2009 9:00:00 AWM 5.100 0.930 0,600 0.950 5140 20 0
5/07/2009 9:00:00 AWM 5100 1.000 0,600 0D.950 5150 30 10
670772009 9:00:00 AWM 5.100 0.980 0,600 0.930 5150 30 0
7/07/2009 9:00:00 AWM 5.100 0.970 0,600 0.960 5.110 -10 -40
870772009 9:00:00 AM 5100 0.980 0,600 D940 5140 20 an
A AsnTiAnAn AAnAn At - cannl nnan P l“nn ananl Eann an an ~
- Row 1
of 23

4.3.2 Output Reports
1 Logs | MON DEEP DATUM INSTALLATION LOG
1 Graphic Table | MON DEEP DATUM READINGS
1 Graphs | MON SETTLEMENT VERSUS TIME PLOT
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4.4 Settlement Marker

4.4.1 Installation

The Displacemetable is used to store the details of the settlement marker installation for a PointID. The
selected Monitoring PdiDon the Displaceme(upper) table should be Instrument and the Typeshould be
MSET.

22 INPUT - pi\products\menitering tool\gint files\1.03\menitering teel 1.02.gpj: MON_DISPLACEMENT table Library: pi\products\menitering tool\gint files\1.0\mon [ = || = |[=£34]
File Additional Modules Edit Format Tools Tables gINT Rules Add-Ins  Mavigation Help
=R RSN N =N N =N = \[EEE =

INFUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES |

Main Group | Driling | Piezometer  Di | Lists | AGS | Site Map |
Displacement | Rod Sellement Gavge | Magnetic Extensometer | Magnetic Elensameter Set | Magnetic Estensometer Probe |
[Displacement group] Table Help
>
Monitoring PointlD | Short ID Type Rod Description Rod Rod Concrete Concrete Concrete Deep Datum  Deep Datum
Stickup Depth  Dimension Dimension Depth Pipe Depth Pipe Stickup
[mm) [mm) (mm) Type (mm) [m) [m)

MSET 20 mm dia. 1325 mm long steel rod. 50 200 100 Square 200
- Top domed and centre punched.

< . »

of 1

MName=Itemkey. Monitaring PointlD . | Row 1

‘[D' Readings] MSET-1.I Table Help

Date/Time Stage Bench Back Heightof Front F4 Displacement Displacement X Displacement Displacem -
[dd/mm/yyyy hhmm) Mark Z | Sight Instrument | Sight [m] z Change Z [m] ent
m | (m [m] m) (mm) (mm) (mm] Change X
(mm) | &
170772009 11:00:00 AM 5.100| 1.000 0.600| 0.980, 5120 1}
2/0772009 1:15:00 PH 5.100) 1.010 0.600 0.990 5120 1] 0
3/07/2009 9:00:00 AWM 5.100| 1.000 0.60D0| D.960, 5140 20 20
470772009 9:00:00 AWM 5.100| 0.990 0.600| 0.950, 5140 20 0
570772009 9:00:00 AWM 5.100| 1.000 0.600| 0.950/ 5150 30 10
670772009 9:00:00 AWM 5.100| 0.980 0.600| 0.930 5150 30 1]
770772009 9:00:00 AWM 5.100| 0.970 0.600| 0.960 5110 -10 -40
870772009 9:00:00 AWM 5.100| 0.980 0.600| 0.940| 5140 20 30 -
] . »
Row 1
of 23

The installation details about the Deep Datum monitoring installation are then entered into the Rod
StickupRod DepttConcrete Dimensamd Concrete Defdiklds on the Displaceme(upper) table. The Deep
Datum Pipe Depiteep Datum Pipe Stickgep Datum Outer Pipe DemdlDeep Datum Outer Pipe Stitdds
are not applicable to a Settlement Marker installation and should be left blank.

Monitoring PointlD | Short ID Type Rod Description Rod Rod Concrete | Concrete  Concrete
Stickup Depth | Dimension| Dimension Depth
[mm] [mm]) [mm] Type [mm]

MSET | 20 mm dia. 1325 mm long steel rod. 50 200 100 | S5quare 200
- Top domed and centre punched.

4.4.2 Monitoring Readings

The settlement marker monitoring readings are recorded on the Displaceme(iower) table by entering
the date and time when the monitoring occurred in the Date Timfeld and the survey information in the
Bench Mark the Back Sitehe Front Sitand (optionally) the Height of Instruméalds.

You may also enter data in the Zfield and leave the Bench Mark Back SiteFront Sitand Height of Instrument
fields blank.
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2= INPUT - p\products\monitaring tool\gint files\1.03\monitering teol 1.03.gpj: MON_DISPLACEMENT table Library: p\productsimoenitoring toolgint files\1.03\mon [ = || = |[s£3s]
File Additional Modules Edit Format Tools Tables gINTRules Add-Ins Mavigation Help

= S (EE = N N = I = (e =

INPUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES |

Main Group | Driling | Piezometer Displacement | Lists | AGS | Site Map |

Displacement | Rod Settlement Gauge | Magnetic Extensometer | Magnetic Estensometer Set__ | Magnetic Estensometer Piobe |
[Displacement group] Table Help
>
Monitoring PointlD | Short ID Type Rod Description Rod Rod Concrete  Concrete Concrete Deep Datum  Deep Datum
Stickup Depth  Dimension| Dimension  Depth Pipe Depth | Pipe Stickup
[mm) [mm) (mm) Type (mm) (m) (m)

MSET 20 mm dia. 1325 mm long steel rod. 50 200 100 Square 200
- Top domed and centre punched.

« n »

Mame=ltemKey. Monitoring PointlD - | F\nrv: 1
o
| [Di Readings]  MSET-1.l Table Help
Date/Time Stage Bench Back Height of Front Z Displacement  Displacement X Displacement | Displacem | -~
[dd/mm/yyyy hhmm] Mark Z Sight Instrument Sight [m) z Change Z [m]) X
[m) [m) [m) [m) (mm) [mm) [mm) Change X | _
[mm) £
1/07/2009 11:00:00 AWM 5100 1.000 0,600 D980 5120 0
270742009 1:15:00 PH 5.100 1.010 0,600 0990 5.120 L1} o
370772009 9:00:00 AM 5100 1.000 0,600 D960 5140 20 20
4/07/2009 9:00:00 AWM 5100 0.930 0,600 D950 5140 20 o
570772009 9:00:00 AWM 5.100 1.000 0,600 0.950 5.150 30 10
67072009 9:00:00 AM 5100 0.980 0,600 D930 5150 30 o
770772009 9:00:00 AWM 5100 0.970 0,600 D960 5110 -10 -40
870772009 9:00:00 AWM 5.100 0.980 0,600 0.940 5.140 20 20 -
I m b
| Fowe 1
of 23

The Zand Displacemeftvalues are calculated based on the monitoring readings and the Displacement

Changé field value is calculated from the base field value.

4421 Base Reading

The base field value can be set in two ways:

1. Automatically. If a recorded result is the initial reading for that deep datum installation, you can
check the Basdfield on the Displaceme(lower) table to indicate this and the base reading will be
displayed in the applicable Basevalue fields on the Displaceme(upper) table. If you check more

than one reading as the base reading, then the value displayed in the Basefield will be an

average of these readings.

2. Manually. If you wish to manually record the base values of the installation, then check the
Manually S8asefield on the Displaceme(upper) table and enter this data into the base value
fields. If you want to calculate these values, then leave these fields blank and d o nclbetk the

Manually S8asefield.
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2 INPUT - pi\productsimanitoring toolgint files\1.05\datgel manitoring tool 1.05.gpj: MON_DISPLACEMENT table Library: pi\productsimanitaring toolgint files\l | = || =1 |[weaw]
File Additional Modules Edit Format Tools Tables gINTRules Add-Ins Nevigation Help

e El sl S & B ) EMeEr =]
INPUT DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES
Main Group | Driling | Piezometer. D [Lists T ags T site map [
Displacement | Fod Setlemert Gauge | Magnetic Extensometer | Magretic Exlensometer Set | Magreti E Frobe |

[Displacement group] Table Help
>

Monitoring PointiD <= Remark Base X BaseY BaseZ Base Date Start Base Date End Manuallp  Date Stopped
(m) [m]) [m]) (dd/mm/yyyy hhmm] | [dd/mm/ypyy hhmm] Set Base Monitoring
[dd/mm/yyyy]
General remark 5120 1/07/2009 11:00:00 | 2/07/2009 1:15:00
o AW PM 0
* O
] mn r

Name-ltemkey. Monitoring PointiD p ‘ Fow 1
of1

‘[D' Readings] MSET-1.I Table Help

Date/Time <= Logged Processed Processed Checked Checked Date Approved Approved Date Reading File -
[dd/mm/yyyy hhmm] Base By By Date By [dd/mm/Zyyyy) By [dd/mm/yyyy hhmm] =~ Status Relerence 7
Reading [dd/mm/yyyy]

1/07/2009 11:00:00 AWM LB cB 1/07/2009 AB 1/0742009 11:00:00 3 ‘ ‘

2/07/2009 1:15:00 PM LB DG 2/07/2009 AB 270772009 1:15:00 W
3/07/2009 9:00:00 AWM O LB CcB 3/07/2009 AB 3/07/2009 9:00:00
470772009 9:00:00 AWM O LB DG 470772009 AB 4/07/2009 9:00:00
570772009 9:00:00 AM O LB CcB 5/07/2009 AB 5/07/2009 9:00:00
670772009 9:00:00 AWM O LB DG 6/07/2009 AB 6/07/2009 9:00:00
770772009 9:00:00 AWM O LB CB 710772009 AB 770772009 9:00:00

8/07/2009 9:00:00 AM O LB DG 8/07/2009 AB 8/07/2009 9:00:00 i

= smmmees 2 am an a0 = — —— _— -

- Row 1
of 22

4.5 Output

45.1 Output Options

The Displacement Minimamd Displacement Maxinfiglds are used to determine the minimum and
maximum settlement axis values for each Monitoring Pointb the deep datum monitoring reports. The
values entered into these fields override the values specified on the Monitoring Project Opttable.

If a minimum and maximum value is not specified in the Displacement Minimamd Displacement Maximum
fields on the Displacemetdable nor in the respective fields on the Monitoring Project Opttabte, then the
minimum and maximum reading values recorded in DisplaemenReadingtable are used to define the
settlement axis extents on the reports.
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= INPUT - p:\products\monitaring tool\gint files\1.05\datgel monitaring tool 1.05.gpj: MON_DISPLACEMENT table Library: p\products\monitoring toohgint files\l [ || =1 |[uEal]
File Additional Modules Edit Format Tools Tables gINTRules Add-Ins Mavigation Help

5|

UTILITIES

Main Group - Piezometer  Di Lists | AGS m
Displacement Rod Settlement Gauge tagnetic Extensometer Magnetic Extensometer Set Magnetic Extensometer Probe
[Displacement group] Table Help |
>
Monitoring PointlD <= Date Stopped Monitoring Reason Stopped Monitoring Remark Displ: Displ; File
Manually [dd/mmZpyyy] Monitoring Minimum Maximum Reference
Set Base (mm) [mm]
< |
® O
‘ n 3
Name=ltermkey. Monitaring PaintlD - Fow1

of 1

|"" Readings] ~ MSET-1.l TahIEHalpl

Date/Time Stage Bench Back Heightof Front 2z Change Change x Change Change Y Chan | »
(dd/mm/ypyy hhmm) Mark Z Sight Instrument Sight [m) ZFrom Z From [m) X From X From [m) geY
m  (m) m) [m) Base | Previous Base Previous From
(mm] | [mm] (mm] | (mm) Base | =
170772009 11:00:00 AWM 5.100 1.000 0,600 0.980 5120 L1}
270772009 1:15:00 PM 5100 1.010 0600 0990 5120 0 1]
370772009 9:00:00 AWM 5.100 1.000 0,600 0.960 5.140 20 20
4707/2009 9:00:00 AWM 5.100 0.930 0,600 0.950 5140 20 0
5/07/2009 9:00:00 AWM 5100 1.000 0,600 0D.950 5150 30 10
670772009 9:00:00 AWM 5.100 0.980 0,600 0.930 5150 30 0
7/07/2009 9:00:00 AWM 5.100 0.970 0,600 0.960 5.110 -10 -40
870772009 9:00:00 AM 5100 0.980 0,600 D940 5140 20 an
A AsnTiAnAn AAnAn At - cannl nnan P l“nn ananl Eann an an ~
- Row 1
of 23

45.2 Output Reports
T Graphs | MON SETTLEMENT MARKER INSTALLATION
T Graphic Table | MON SETTLEMENT READINGS
1 Graphs | MON SETTLEMENT VERSUS TIME PLOT RPT
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S Rod Settlement Gauges

51 Installation

The Rod Settlement Gaygeper) table is used to store the details of the settlement marker installation for
a PointID.

22 INPUT - p:\preducts\monitoring toolgint files\1.03\monitoring toel 1.03.gpj: MON_ROD_SETTLEMENT_GAUGE table Library: p:\products\menitoring toohgint files\ |~ = || = |[5£30]
File Additional Modules Edit Format Tools Tables gINT Rules Add-Ins  MNavigation Help
e T N = = = R |
INPUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES
Main Group | Drilling | Pi D:i: | Lists | AGS | Site Map |
Displacement Rod Setlement Gauge | Magnetic Extensometer | Magnefic Extensometer Set | Magnstic E Probe |
[Displacement group] Table Help
b
PointlD Rod Description Date Installed Remark Gauge Base | Fill Base Base Date Start
(dd/mm/yypy hhmm) Elevation | Elevation | (dd/mm/yyyy hhmm)
(m) (m)
+ | Description about the Rod 30/06/2003 11:15:00 AM Remark about the Settlement Gauge 2.370 359 1/07/2009 11:00:00
RSG-2 Description about the Rod 30/06/2009 11:15:00 AM | Remark about the Settlement Gauge 2.620 3.84 1/06/2009 11:00:00
*
« I v
R Fow 1
of 2
‘ [Rod Setdement Gauge Readings]  RSG-1 Table Help
Date/Time Bench | Back Heightof Top Rod Fill Gauge Base TopRod Gauge Gauge Gauge Fill Fill -
[dd/mm/yyyy hhmm) Mark Sight Instrument  Front Front  Length Elevation Elevation Displ Displ: Elevation Displ:
Elevation [m) [m) Sight Sight [m) [m) [m) Base Previous [m) ment
(m} (m] [m) [mm] [mm]) Base
170772009 11:00:00 AWM 4.850| 0.500 1.010 0980 1.760 2000 4.370 2370 0 3.590 0=
270772009 1:15:00 PH 4.850| 0.510 1.030 0.990) 1.770 2000 4.370 2370 L1} 1} 3.590 LIl
3/07/2009 9:00:00 AM 4.850| 0.500 0.980 1.0000 1.780 2000 [] 4.350 2.350 -20 -20 3.570 -0
470772009 9:00:00 AM 4.850| 0.490 1.000 10100 1.790 2000 [] 4.330 2330 -40 -20 3.550 -0
570772009 9:00:00 AM 4.850| 0.500 0.990 1.020) 1.800 2000 [] 4.330 2.330 -40 i} 3.550 -0
B6/07/2009 9:00:00 AM 4.850| 0.480 1.010 1.030) 1.810 2000 [] 4.300 2.300 -70 -30 3.520 -0
770772009 9:00:00 AM 4.850| 0.470 1.020 1.040) 1820 2000 [] 4.280 2280 -90 -20 3.500 -0
870772009 9:00:00 AM 4.850| 0.480 1.040 1050, 1830 2000 [] 4.280 2280 -90 0 3.500 -0
970772009 9:00:00 AM 5.850| 0.440 0.990 1.060) 1.840 32000 [] 5.230 2230 -140 -50 4.450 L}
10/07/2009 9:00:00 AM 5850 0.410 1.010 1070, 1850 3000 [] 5190 2190 -180 -40 4410 LI}
11/07/2004 8-N0-NN AW R RN N 420 1nnn 1ngnl 18kl znonl K1an 2180 180 nl a44n n-
< m »
Row 1
of 24

Select an available PointID and enter the associated metadata in the RodDescriptigiiDatelnstalleénd
Remarlields.

5.2 Monitoring Readings

The rod settlement gauge monitoring readings are recorded on the Rod Settlement Galgsver) table by
entering the date and time when the monitoring occurred in the Date Timéeld and the survey
information in the Bench Maiklevatigrthe Back Sitehe Top Rod Frogite the Fill Froriteand (optionally)
the Height of Instruméetds. The Gauge Lengtalue will be automatically populated with the same value
as the previous record.

You may also enter data in the Top Rod Elevatiand FillElevatiofields and leave the level run related
fields blank.
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<= INPUT - pi\products\manitaring toolgint files\1 03\manitoring tool 1.03.gpj: MON_ROD_SETTLEMENT GAUGE table Library: pr\products\monitoring toohgint files\ | = || = |[mtda]
File Additional Modules Edit Format Tools Tables gINTRules Add-ns Nevigation Help

AT N NG == AN,

INPUT | DUTPUT | DATA DESIGH | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES

Main Group | Driling | Piezometer Displacement | Lists | AGS | Site Map |

Displacement Rod Setfement Gauge | Magnetic Extersometer ], Magnetic Extensometer Set__ |, Magnetic Extensometer Probe.__J
[Displacement group] Table Help
>
PointiD Rod Description Date Installed Remark Gauge Base Fill Base Base Date Start
[dd/mm/yyyy hhmm] Elevation | Elevation [dd/mm/yyyy hhmm])
[m) [m)

[EEEEH ~ | Description about the Rod 30/06/2009 11:15:00 AM | Remark about the Settlement Gauge 2.370 3.59) 1/07/2009 11:00:00

RSG-2 Description about the Rod 30/06/2009 11:15:00 AM Remark about the Settlement Gauge 2.620 3.84| 1/06/2009 11:00:00
x

. T »

- Row 1
of 2

| [Rod Settlement Gauge Readings]  RSG-1 Table Help

Date/Time Bench | Back Heightof TopRod Fill |Gauge Base TopBod Gauge Gauge Gauge Fill Fill -
(dd/mm/yyyy hhmm] Mark | Sight Instrument Front Front | Length Elevation Elevation Displ D:i Elevation Dispk
Elevation [m) [m) Sight Sight [m]) [m) (m) Base Previous [m) ment
[m) [m) [m) [mm) [mm) Base
170772009 11:00:00 AWM 4.850 0.500 1.010 0.980| 1.760| 2.000 4.370 2370 1] 3.590 0=
2/07/2009 1:15:00 PH 4.850 0.510 1.030 0.990| 1.770| 2.000 4.370 2370 1] L1} 3.590 0
3/07/2009 9:00:00 AM 4.850 0.500 0.980 1000 1.780| 2000 [] 4.350 2350 -20 -20 3570 -0
470772009 9:00:00 AM 4.850 0.490 1.000 1.010) 1.790| 20000 [] 4.330 2.330 -40 -20 3.550 -0
5/07/2009 9:00:00 AM 4.850 0.500 0.930 1.020) 1.800| 2000 [] 4.330 2330 -40 L1} 3.550 -0
6/07/2009 9:00:00 AM 4.850 0.480 1.010 1030 1810 20000 [] 4.300 2300 -70 -30 3520 -0
770772009 9:00:00 AM 4.850 0.470 1.020 1.040) 1.820| 2000 [] 4.280 2280 -90 -20 3.500 -0
8/07/2009 9:00:00 AM 4.850 0.480 1.040 1.050) 1.830| 20000 [] 4.280 2.280 -90 L1} 3.500 -0
9/07/2009 9:00:00 AM 5850 0.440 0.930 1.060| 1840 3000 [] 5230 2230 -140 -50 4.450 0
10/07/2009 9:00:00 AWM 5850 0.410 1.010 1070 1850 3000 [] 5190 2130 -180 -40 4410 0
11/0742009 9-N0-NN AW K RRN N 420 1 nnn 108N, 1 8RN 3 NN r k1an 2149n -180 n 4410 n-
“ I »
| Fowe 1
of 24

The Top Rod Elevati@augeElevatianGaugeDisplacemeRtrevioudrillElevatioand Fill Displacement Previous
values are calculated from the monitoring readings and the GaugeDisplacemeBaseand FillDisplacement

Basefield values are calculated based on the base field value.

5.2.1 Base Reading

The base field value can be set in two ways:

1. Automatically. If a recorded result is the initial reading for that rod settlement gauge installation,
you can check the Basedfield on the Rod Settlement Ga(iosver) table to indicate this and the
base reading will be displayed in the applicable Basevalue fields on the Rod Settlement Gauge

(upper) table. If you check more than one reading as the base reading, then the value

displayed in the Basefield will be an average of these readings.

2. Manually. If you wish to manually record the base values of the installation, then check the
Manually S8asefield on the Rod Settlement Gaggjgper) table and enter this data into the base
value fields. If you want to calculate these values, then leave these fields blank and d o ncldetk

the Manually SBasefield.

Monitoring Tool gINT Add-In T

Datgel

User Guide 33 DMT-UG-001 - 1.03- November 2009



2= INPUT - pi\products\monitoring tool\gint files\1.05\datgel menitoring tool 1.05.gpj: MON_ROD_SETTLEMENT_GAUGE table Library: p:\products\menitoring toohgint | — || = |[s£3]
File Additional Modules Edit Format Tools Tables gINT Rules Add-Ins Navigation Help
= e B NE R =N~ N = W=
INPUT | DUTPUT | DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES
Main Group | Driling | Piezometer  Di | Lists | AGS | Site Map |
Displacement Rod Setdement Gauge | Magnetic Extensometer ] Magnetic Extensometer Set_ | Magnstic E Probe |
[Displacement group] Table Help
>
PointiD <= Remark Gauge Base Fill Base Base Date Start Base Date End Manually Date Stopped Monitoring  as
Elevation  Elevation (dd/mm/pyyy hhmm) | {dd/mm/ypyy hhmm]  Set Base [dd/mmZyyyy) I
[m) [m) ite
[EEEN ~ | Remark about the Settlement Gauge 2.358 3.590 1/07/2009 11:00:00 | 2/07/2009 1:15:00 ]
R5G-2 Remark about the Settlement Gauge 2.608 3.840 1/06/2009 11:00:00 | 2/06/2009 1:15:00 |
B ]
« »
= [ Fowl
of 2
‘ [Rod Settlement Gauge Readings]  RSG-1 Table Help
Date/Time Bench | Back | Heightof TopRed Fill Gauge| Base TopRod | Gauge  Gauge Change Gauge Change  Fill Fill | -
{dd/mm/ypyy hhmm) Mark | Sight Instrument Front | Front Length| Reading Elevation Elevation Elevation From Elevation From Elevation Chan
Elevation [m) [m) Sight Sight [m) [m) [m) Base Previous (m) ge
(m) (m) [(m) [mm) [mm]) Elev
1/07/2009 11:00:00 AM 4.850| 0.500 1.010, 0.980| 1.760 2.000 4370  2.358 0 3.590 L
2/07/2009 1:15:00 PM 4.850| 0.510 1.030, 0.990| 1.770 2.000 4370  2.358 0 0 3590
3/07/2009 9:00:00 AM 4.850| 0.500 0980 1.000/ 1.780 2000 [ 4350 2338 20 200 3570
4/07/2009 9:00:00 AM 4.850| 0.450 1.000 1.010/ 1.790 2000 [ 4330 2318 -40 20, 3550
5/07/2009 9:00:00 AM 4.850 0500 0.990 1.020/ 1.800 2000 [ 4330 2318 -40 0 3550
6/07/2009 9:00:00 AM 4850 0480 10100 1.030] 1.810 2000 [ 4300 2288 70 300 3520
7/07/2009 9:00:00 AM 4.850| 0470 1.020 1.040/ 1.820 2000 [ 4280 2.268 -30 20, 3500
8/07/2009 9:00:00 AM 4.850 0480 1.040 1.050/ 1.830 2000 [ 4280  2.268 -90 0 3500
9/07/2009 9:00:00 AM 5.850 0440 0990 1.060| 1.840 3000 [ 5230 2218 140 50 4.450
10/07/2009 9:00:00 AM 5.850) 0.410 1.0100 1.070| 1.850 3000 [ 5190 2178 -180 40 4410 8
« n v
. Row1
of 24

5.3 Output Options

The Gauge Displacement MiniandhGauge Displacement Maxifialts are used to determine the minimum
and maximum displacement axis values for the rod settlement gauge monitoring reports. The values
entered into these fields override the values specified on the Monitoring Project Opttabte.

If a minimum and maximum value is not specified in the Gauge Displacement MiniamadrGauge
Displacement Maxinfiglds on the Rod Settlement Gatalse nor in the respective fields on the Monitoring
Project Optiotable, then the minimum and maximum reading values recorded in the Rod Sel#gment Gauge
Readingtable are used to define the gauge displacement axis extents on the reports.

The FillDisplacement Minimamd FillDisplacement Maxinfigids are used to determine the minimum and
maximum displacement axis values for the fill materials surrounding the rod settlement gauge on the
monitoring reports. The values entered into these fields override the values specified on the Monitoring
Project Optiotable.

If a minimum and maximum value is not specified in the FillDisplacement Minimand FillDisplacement
Maximurfields on the Rod Settlement Gatalale nor in the respective fields on the Monitoring Project Options
table, then the minimum and maximum reading values recorded in the Rod Settlement Gauge Reatabtgs
are used to define the gauge displacement axis extents on the reports.
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File Addi

nal Modules  Edit Format Tools Tables gINT Rules Add-Ins  Mavigation Help

INPUT

Main Emu; - Piezometer  Di: sts | AGS m
Displacement Rod Settlement Gauge tagnetic Extensometer Magnetic Extensometer Set Magnetic Extensometer Probe
[Displacement group] Table Help |
>
PointiD <= Reason Stopped Monitoring Remark  Gauge Displ Gauge Di Fill Displ. Fill Displ: File
Monitoring Minimum Maximum Minimum Haximum Reference
(mm) [mm) (m) (m)

R - -700 50 -0.5

RSG-2
x

- Fow 1
i of 2
| [Rod Settement Gauge Readings] RSG-1 T able He"’l
Date/Time Bench | Back Heightof TopRod Fill Gauge Base TopHod Gauge Gauge Change Gauge Change Fill Fill | -
(dd/mm/yyyy hhmm] Mark | Sight Instrument Front Front | Length Reading Elevation Elevation Elevation From Elevation From Elevation Chan
Elevation [m) [m) Sight Sight [m) [m) [m) Base Previous [m) ge
(m) (m) (m) [mm]) [mm] Elev
170772009 11:00:00 AWM 4.850 0.500 1.010 0.980| 1.760| 2.000 4.370 2.358 0 3.590 =
2/07/2009 1:15:00 PH 4.850 0.510 1.030 0.990| 1.770| 2.000 4.370 2.358 0 0 3.530
3/07/2009 9:00:00 AM 4.850 0.500 0.980 1.000| 1.780| 2000 O 4350 2338 -20 -20 3570
4/07/2009 9:00:00 AM 4.850 0.430 1.000 1.010) 1.790| 2000 O 4330 2318 -40 -20 3.550
5/07/2009 9:00:00 AM 4.850 0.500 0.930 1.020| 1.800| 2000 (| 4.330 2318 -40 0 3.550
6/07/2009 9:00:00 AM 4.850 0.480 1.010 1.030| 1.810 2000 O 4.300 2288 -70 -30 3520
70772009 9:00:00 AM 4.850 0.470 1.020 1.040) 1.820| 2000 O 4280 2.268 -30 -20 3.500
870772009 9:00:00 AM 4.850 0.480 1.040 1.050| 1.830| 2.000 (| 4.280 2.268 -90 0 3.500 1
9/07/2009 9:00:00 AW 5850 0.440 0.930 1.060| 1.840 3000 O 5.230 2218 -140 -50 4.450
10/07/2009 9:00:00 AWM 5850 0.410 1.010 1.070| 1.850 3000 O 5190 2178 -180 -40 4.410 i
< m ] v
- Row 1
of 24

o
= INPUT - pi\products\monitoring toolgint files\1.05\datgel monitoring tool 1.05.gpj: MON_ROD_SETTLEMENT_GAUGE table Library: p:\productsimonitoring toohgint |- = || = | (s3]

54 Output
1 Graphs | MON ROD SETTLEMENT GAUGE INSTALL
1 Graphic Table | MON ROD SETTLEMENT GAUGE READINGS
1 Graphs | MON RSG VERSUS TIME PLOT RPT
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6 Magnetic Extensometer

6.1 Reference Tables

This table contains standard information that is referenced by the other Magnetic Extensometer tables.
It can be edited to suit the needs of an individual project and, if it is incorporated into your data
template, the information will available in each new project file that is cloned from the new data
template.

6.1.1 Magnetic Extensometer Probe

The Magnetic Extensometer Ptalile is used to store the relevant details of each type of magnetic
extensometer probe used to monitor the installation. The Codegiven to the Probe I2an then be picked
on the Magnetic Extensometetasé.

tagnetic Extensometer Probe

MName=Itemkey. -
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6.2 Installation

6.2.1 Backfill

Define the backfill material and range in the Backfiltable.

&2 INPUT - p:\products\monitoring toohgint files\1,05\datgel menitoring tool 1.05.gpj: MON_BACKFILL table Library: p:\productsimonitoring toolgint files\1,05 (===l
File Additional Modules Edit Format Tools Tables gINTRules Add-Ins Navigation Help

— o = [ @ & &S B[] e 5|
INPUT SYMBOL DESIGN | DRAWINGS | UTILITIES

Main Group | Drilling | Piezometer | Displacement | Lists | AGS | Site Map |
Piojet | Point | SuataMsin | Backll | Monitoing Froject Dptions | Moritoring Poink Options |1

[rain Group group] Table Help

Top Bottom Material Pointer Remark Grout Type Telescope Date File
[m) [(m) Level (dd/mm/yyyy] | Reference

0.00 7.50 G

Grout Bentonite/Cement Grout

Name=Diepth. Depth ta top of section ~ [ FRowl
of 1

6.2.2 Magnetic Extensometer

The general magnetic extensometer installation details are entered on the MagnetiExtensomatéupper)
table. Select an available PointID and the reference point relative to which the magnet elevations are
monitored from in CalculatioMethodield. Enter the associated metadata in the Stickup of Ref Ppdepth
Access Tukend Remarffields as required.

Main Group | Drilling | Piezometer Displacement | Lists | AGS | Site Map |

Displacement | Aod Settlement Gauge Magnetic Extensometer Magnetic Extensometer Set | Magnetic Extensometer Probe _
[Displacement group] Table Help
>

PointiD Calculation Method | Stickup of Elevation Depth Remark
Ref Point | Reference Point | Access Tube
(m) m
+ | Top Access Tube 1.00 6.90 7.400| a small remark
1.00 6.90 7.400

a small remark

Datum

~ Fow1
i of 2
| ic E Base Readings] MEX-1 7.2ble Help
Magnet | Datum Date Installed Depth Distance Elevation Base Date Start Base Date End Reason Stopped Monitoring Remark
Magnet | (dd/mm/yyyy hhmm] Relerence Above Datum [m]) [dd/mm/yyyy hhmm] = [dd/mm/yyyy hhmm]
Point Magnet
[m] [m]
7 O 370772003 10:00:00 5.060 3/07/2009 11:15:00 3/07/2009 11:15:00
B[ [ 170772009 9:00:00 4.150 1/07/2009 11:00:00 2/07/2009 11:30:00
5 O 1/07/2009 9:00:00 3.149 1/07/2009 11:00:00 2/07/2009 11:30:00
4 O 1/07/2009 9:00:00 2149 1/07/2009 11:00:00 2/07/2009 11:30:00
I O 170772009 9:00:00 1.148 1/07/2009 11:00:00 2/07/2009 11:30:00
2l O 1/07/2009 9:00:00 0.149 1/07/2009 11:00:00 2/07/2009 11:30:00
1 O 1/07/2009 9:00:00 -0.841 1/07/2009 11:00:00  2/07/2009 11:30:00
* ||
[ . "
- Row 1
of 7

The magnet number and the installation date must then be entered in the Magneand the Date Installed
fields on the Magneti&xtensometéower) table.

The Elevation Reference Point field is calculated by using the Elevatiofield value on the Pointable plus
the value of the Stickup of REbintfield.
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6.2.2.1 Datum Elevation Reference Point

If the magnet elevations on the Magnetic Extensomé&tei(lower) table are to be calculated from a fix

reference point (e.g. from a magnet installed in a rock layer), then you should select the Datum option
in the CalculatioMethodield on the Magneti&xtensometéupper) table and the Datum Magnield of the

corresponding magnet on the Magneti&xtensomet@ower) table must be checked (as below).

2= INPUT - pi\products\menitering toel\gint files\1.05\datgel menitering tool 1.05.gpj: MON_MAGNETIC_EXTENSOMETER table Library: p:\products\menitoring tool\... | = || = |[s23]
File Additional Modules Edit Format Tools Tables gINT Rules Add-Ins  MNavigation Help

S EH cleds s E A

INFUT | DUTPUT | DATA DESIGN | REPORT DESIGH | SYMBOL DESIGN | DRAWINGS | UTILITIES

Main Group | Drilling | Pi D | Lists | AGS | Site Map |

Displacement Rod Settlement Gauge Magnetic Extensometer ‘ Magretic Extensometer Set | Magnetic Extensometer Probe |

IDisplacement group] Table Help
¥

PointD Calculation Method | Stickup of | Elevation Depth Remark Date Stopped
Ref Point Reference Point Access Tube Monitoring
[m) (m) (m) [dd/mm/yyyy)
MEX-1 Top Access Tube 1.00 6.90 7.400 a small remark
MEX-2 ~ | Datum 1.00 6.90 7.400 | a small remark
=
] m r
Row2
of 2
‘ M ic E. Base Readings] MEX-2 Taable Help
Magnet = Datum Installation Date Depth Distance Elevation Base Date Start Base Date End Date Stopped Monitoring  Reason Stopped
Magnet | (dd/mm/yyyy hhmm] Relerence Above Datum [m) [dd/mm/yyyy hhmm]  [dd/mm/yyyy hhmm]) [dd/mm/yyyy) Monitoring
Point Magnet
(m) (m)

5.900 6.810 3/07/2009 11:15:00  3/07/2009 11:15:00
4.990 5.900 1/07/2009 11:00:00 2/07/2009 11:30:00
3.990 4.900 1/07/2009 11:00:00 2/07/2009 11:30:00
2.990 3.899 1/07/2009 11:00:00 2/07/2009 11:30:00
1.989 2.899 1/07/2009 11:00:00 2/07/2009 11:30:00
0.990 1.900 1/07/2009 11:00:00 2/07/2009 11:30:00
5.991 0.000 0.910 1/07/2009 11:00:00 2/07/2009 11:30:00

—inw oo
0= 000|000

of 7

‘ - Row1

6.2.2.2 Top Access Tube Elevation Reference Point

If the magnet elevations are to be calculated from the top of the access tube, the elevation level of

which may change over the course of the monitoring period, then you should select the Top Access
Tube option in the CalculatioMethodield on the Magneti&xtensometéupper) table. A typical scenario
where you would wish to select this option would be for a magnetic extensometer installation on a land
reclamation project. If the Top Access Tube option has been selected in the CalculatiomMethodield, then

Datum Magnfi¢lds on the MagnetiExtensomet@ower) table must be unchecked.
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&= INPUT - p:\products\monitoring toolgint files\1.05\datgel monitoring tool 1.05.gpj: MON_MAGNETIC_EXTENSOMETER table Library: p:\products\monitoring tool... | = || = |[s£3s]
File Additional Modules Edit Format Tools Tables gINTRules Add-Ins Navigation Help

=R RSN e G & E A
INPUT

Main Group | Diilling | Piezometer D
Displacement | Flod Setlement Gauge Magnetic Extensometer Magnetic Extensometer Set | Magnetic Extensometer Probe |

[Displacement group] Table Help
>

PointiD Calculation Method  Stickup of Elevation Depth Remark Date Stopped
Ref Point  Reference Point | Access Tube Monitoring
(m) (m) (m) [dd/mm/pyyy)
~ | Top Access Tube 1.00 6.90 7.400 | a small remark
MEX-2 Datum 1.00 6.90 7.400 | a small remark
x

4 m 3
- Fiow 1
i of2
| ic E Base Readings] MEX-1 7 able Help
Magnet | Datum Installation Date Depth Distance Elevation Base Date Start Base Date End Date Stopped Monitering | Reason Stopped
Magnet | (dd/mm/yyyy hhmm] Reference Above Datum [m]) [dd/mm/yyyy hhmm] = [dd/mm/yyyy hhmm) [dd/mmZyyyy] Monitoring
Point Magnet
(m) (m)
7 O 3/07/2009 10:00:00 5.060 3/07/2009 11:15:00 3/07/2009 11:15:00
B[ [ 1/07/2009 9 4.150 1/07/2009 11:00:00 2/07/2009 11:30:00
5 O 1/07/2009 9: 3.149 1/07/2009 11:00:00 2/07/2009 11:30:00
4 O 1/07/2009 9:00:00 2149 1/07/2009 11:00:00 2/07/2009 11:30:00
I O 170772009 9:00:00 1.148 1/07/2009 11:00:00 2/07/2009 11:30:00
2 O 1/07/2009 9:00:00 0.149 1/07/2009 11:00:00 2/07/2009 11:30:00
1 O 1/07/2009 9:00:00 -0.841 1/07/2009 11:00:00  2/07/2009 11:30:00
* ||
« n 3
- Fiow 1
of 7

IMPORTANT | If you select the Top Access Tube option in the Calculatioklethodield on the Magnetic

Extensometéupper) table then you must first enter the survey information on the Displacemeifiiables before

you enter the monitoring results on the Magneti&xtensomet&ettables.

If the Top Access Tube option in the CalculatioMethodield on the MagnetiExtensometéupper) table is
selected then the selected Monitoring PointdB® the Displacemef(upper) table for the PointID must be Top
Access Tube. The Typewould be MSET. The survey data is then entered on the Displaceme(ibwer)

table.

Q INPUT - p\products\monitoring tool\gint files\1.05\datgel moenitering tool 1.05.gpj: MON_DISPLACEMENT table Library: pi\preductsimenitoring toolhgint files\l E=n E
File Additional Modules Edit Format Tools Tables gINT Rules Add-Ins  MNavigation Help

DATA DESIGN | REPORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES—

Main Group | Drilling | Piezometer Displacement _AGS | Site Map |

Displacement Rod Settlement Gauge: Magnetic Extensometer Magnetic Extensometer Set Magnetic Extensometer Probe
[Displacement group] Table Help
b
Monitoring PointiD | Short ID | Type Rod Description Rod Rod  Concrete | Concrete | Concrete | Deep Datum Deep | -
Stickup Depth Dimension Dimension Depth Pipe Depth  Datum Pipe
[mm) [mm) [mm] Type [mm] [m) Stickup
(m)

ound MSET | Rod Description

Top Access Tube MSET | Rod Description
* -
< 1 3
Name=ltemKey. Monitoring PointlD - Fow 1
of 2
| [Displacement Readings]  MEX-1_Ground 7.2ble Help
Date/Time Stage Bench Back Height of Front z Change  Change X Change Change Y Change
(dd/mm/ypyy hhmm) Mark 7 Sight Instument Sight [m) ZFrom | Z From [m] % From X From m | Y From
[m) [m) [m) [m) Base Previous Base Previous Base
[mm) [mm) [mm) [mm] [mm]
1/07/2009 11:00:00 AM 5100 1.000 0980 5120
270772009 11:30:00 AM 6.000
370772009 11:15:00 AWM 7.000
4/07/2009 2:00:00 PM 8.000
570772009 11:59:00 AM 8.000
x
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By selecting the Top Access Tube option in the Calculatiomethodield, the Elevatiofield value on the
Magnetic Extensometei(l8wter) table is calculated by using the Zfield value on the Displaceme(lower)
table that was recorded at the most closely corresponding Date/Time to the monitoring result on the

Magnetic Extensometer(@gper) table for each magnet on the Magnetic Extensometer(l6eter) table.

6.3 Monitoring Readings

The general magnetic extensometer monitoring readings are recorded on the Magneti&xtensomet&et
(upper) table by entering the date and time when the monitoring occurred in the Date Timfeld and the
associated metadata in the remaining fields.

The reading for each magnet at the time when the monitoring occurred is recorded on the Magnetic
Extensomet&et(lower) table by entering the recorded depth to each magnet in the Depth Reference Point
field.

The Elevatiofield for that magnet is then calculated depending on the selected calculation method on
the Magneti&Extensomet@upper) table.

The Change [Evation From Beamed Change Elevation From Prefi@dds/alues are calculated based on the
base field values on the Magneti&xtensomet@dower) table.

2 INPUT - p\products\monitoring toolgint files\1.05\datgel monitoring tool 1,05.gpj: MON_MAGNETIC_EXTENSOMETER table Library: p:\productsimenitoring tool... EI@
File Additional Modules Edit Format Tools Tables gINT Rules Add-Ins  MNavigation Help
e T N = = = R |
INPUT | DUTFUT | DATA DESIGN | REFORT DESIGN | SYMBOL DESIGN | DRAWINGS | UTILITIES |
Main Group | Drilling | Pi Di [ Lists | AGS | Site Map |
Displacement | Rod Settlement Gauge Magnetic Extensometer | Magnietic Extensometer 56t | Magnetic E Probe |
[Displacement group] Table Help
b
PointlD <= Date Stopped Monitoring Reason Stopped itoring Remark | Di i
(dd/mmZyyyy) Monitoring Minimum Maximum
[mm) (mm)
MEX-1 - -250 50
MEX-2 -250 50
*
[ n »
Row1
of 2
ic E: Base Readings] MEX-1 Table Help
Magnet | Datum Inzstallation Date Depth Distance Elevation  Base Date Start Base Date End Date Stopped Monitoring  Reason Stopped
Magnet (dd/mm/yyyy hhmm) Reference Above Datum [m) (dd/mm7/yyyy hhmm) [(dd/mm/yyyy hhmm) (dd/mm7yyyy) Monitoring
Point Magnet
[m) (m)
7 O 3/07/2009 10:00:00 5.060 3/07/2009 11:15:00 3/07/2009 11:15:00
6 [ 1/07/2009 3:00:00 4150 1/07/2009 11:00:00 2/07/2009 11:30:00
5 O 1/07/2009 9:00:00 3.149 10772009 11:00:00 2/07/2009 11:20:00
4 [ 1/07/2009 9:00:00 2149 1/07/2009 11:00:00 2/07/2009 11:30:00
i O 1/07/2009 3:00:00 1.148 1/07/2009 11:00:00 2/07/2009 11:30:00
2l O 1/07/2009 9:00:00 0.149 1/07/2009 11:00:00 2/07/2009 11:20:00
11 O 1/07/2009 9:00:00 -0.841| 1/07/2009 11:00:00 2/07/2009 11:30:00
* m]
[] . b
B Row1
of 7

6.3.1 Base Reading

If a recorded result is the base reading for that magnet, you can check the BaseRealingfield to indicate
this and the base reading will be displayed in the Elevatiofield on the Magneti&xtensometéower) table.
If you check more than one reading for each magnet as the base reading, then the value displayed in
the Elevatiofield will be an average of the readings.

6.4 Adding an A dditional Magnet

Additional magnets may be added as fill is added to a reclamation. This can be managed in the Tool by
inserting a new record to the Magnetic Extensomél@®wer) table, and assigning the next Magnehumber

Monitoring Tool gINT Add-In T Datgel
User Guide 40 DMT-UG-001 - 1.03- November 2009



and the Installation Datd@hen when you create a new set of readings the new magnet will appear in the
list, and you should define the Base reading(s) for the magnet as described previously.

6.5 Output

6.5.1 Output Options

The Displacement Minimamd Displacement Maxinfiglds are used to determine the minimum and
maximum settlement axis values for magnetic extensometer monitoring reports. The values entered
into these fields override the values specified on the Monitoring Project Opttabte.

If a minimum and maximum value is not specified in Displacement Minimamd Displacement Maxinfietds
on the Magnetic Extensoméabte nor in the respective fields on the Monitoring Project Opttabte, then the
minimum and maximum reading values recorded in Magnetic Extensom&eadingtable are used to
define the settlement axis extents on the reports.

In addition to the options mentioned above and in Section 2.4.3, you can select which of the monitoring
results you do not want to display on the included log reports by checking the Do Not Repdi¢ld on the
Magnetic Extensometert&de.

Monitoring Tool gINT Add-In T Datgel
User Guide 41 DMT-UG-001 - 1.03- November 2009










































